
Introduction to TeleMagic Internet Mail
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TeleMagic Enterprise V4.0 now provides the user with expanded internal e-mail capability as well 
as fully-integrated Internet e-mail in one easy-to-use package. TeleMagic’s Mail feature has been 
completely redesigned to work even better within your TeleMagic environment, and to work 
independently as a stand-alone application. As with previous versions, you will still enjoy the 
convenience of an automatically updated user address book, easily defined user groups, spell 
checking, and other powerful features.

In addition, you will now be able to send and receive Internet e-mail with TeleMagic Internet Mail, 
send and receive multiple attachments, and organize your incoming and outgoing mail for the 
most efficient and appropriate handling. TeleMagic Internet Mail is designed for use with 
TeleMagic Enterprise. You will now be able to link e-mail messages to your contacts and use 
TeleMagic’s Merge feature to produce targeted mass mailings. The new address book keeps your 
user list up-to-date automatically and your Internet contacts organized.
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Starting TeleMagic Internet Mail
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TeleMagic Internet Mail can be started from within TeleMagic, or opened as a stand-alone 
program. When opened independently of TeleMagic, some features will not be available. For 
example, when opened with TeleMagic open you will be able to link messages to contacts in your 
database. Without TeleMagic open you will not be able to do this.

Warning
If TeleMagic Internet Mail is opened from TeleMagic and a copy is already running, the copy that 
is already open will be brought to the front. User IDs will not be compared. If a workstation is used 
by more than one user, they should insure that TeleMagic Internet Mail is closed before turning 
the workstation over to any other users, even if they have logged off of TeleMagic.

To Start Internet Mail from TeleMagic

1.
From the toolbar, click on the E-mail button ( ).

or From the Office menu, select TeleMagic E-mail.

2. If MAPI is available, and you want to use it, click Yes to 
logon to MAPI. 

The Choose Profile dialog box will open.

3. Select your User Profile from the drop down list.

or Modify a profile, or create a new profile. See your MAPI 
application’s documentation for instructions on adding 
and modifying MAPI profiles.

4. To change the default user or view the logon screens for 
your information services, click Options.

The Options section of this dialog box will open.

5. Click OK.

TeleMagic Internet Mail will open.

To Start Internet Mail from Windows 95, 98 or NT

1. From the taskbar, select Start, Run.

The Run dialog box will open.

2. Enter the file name with complete path in the text 
window.

or Click Browse and use the Browse dialog box to locate 
the file.



3. Click OK.

The TeleMagic E-mail login screen and Mail Login dialog 
box will open.

4. Enter your User ID in the upper field and your password 
in the lower field.

5. Click OK.

The Confirm dialog box will open.

6. Click Yes to logon to MAPI.

The Choose Profile dialog box will open.

7. Select your User Profile from the drop down list.

or Modify a profile, or create a new profile. See your MAPI 
application’s documentation for instructions on adding 
and modifying MAPI profiles.

8. To change the default user or view the logon screens for 
your information services, click Options.

The Options section of this dialog box will open.

9. Click OK.

TeleMagic Internet Mail will open.

Continue…
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Composing and Sending a Message
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To compose a message:
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Start TeleMagic Internet Mail.

1. From the toolbar, click the compose a new message 

button. ( )

The New Message screen will open.

2. Enter the recipient(s) in the To: field.

3. Enter any CC or BCC recipients in the CC: and BCC: 
fields, respectively.

4. Enter the subject in the Subject: field.

5. Compose the message in the message text area.

6.
Click the Spell Check button ( ) to spell check the 
message.

7. Select one of the following:



· Click the Send Message Now button ( ) to 
send the message.

· Click the Send Message Later button ( ) to 
send the message to the Outbox folder.

· Click the Hold Message button ( ) to send the 
message to the On Hold folder.

· Click the Queue to Automation Server button (

) to send the message to the Automation 
Server queue. 

Warning!
You cannot send messages to addressees from 

your MAPI address book via the Automation Server.

· Click the Save Message to Folder button ( ) to 
save the message in one of the TeleMagic Internet 
Mail folders.

The New Message screen will close.

Continue…
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To Read a Message You Have Received:
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To open and read a message:
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Start TeleMagic Internet Mail.

1. In the Folders section of the TeleMagic Internet Mail 
screen, click Inbox if it is not currently selected.

The available messages will be listed to the right of the 
list of folders.

2. Single-click the message you want to read.

The message will appear in the section below the list of 
messages.

or Double-click the message you want to read.

The Message screen will open with the selected 
message displayed.

{ewl rhgbtn32.dll, BlueSkyHelpButton, g<contup01.bmp|
contdn01.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_To_Reply_to_a_Message_You_Have_Received)<
<1}



Using the Address Book to Address a Message
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To select a recipient from the Address Book:

1. Place your mouse cursor near the address line you want 
to fill in. When any of the fields becomes highlighted, left-
click the mouse.

The Select Recipients dialog box will open.

2. Click the tab corresponding to the Address Book you 
want to access.

3. Using the mouse, highlight the name(s) you want 
included in the recipient field.

4. Click on the button corresponding to the recipient list you 
want the selected name(s) added to.

The names will be added to the list.
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To Reply to a Message You Have Received
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Start TeleMagic Internet Mail.

1. Click on the message to which you want to reply.

If you single-click, the message will be displayed in the 
lower-right section of the TeleMagic Internet Mail screen. 
If you double-click, the message will open in the 
Message dialog box.

2.
Click on the Reply to Sender button. ( )

or
Click on the Reply to All button. ( )

The Compose Message dialog box will open with 
addressing information already filled in.

3. Enter any additional recipients in the appropriate 
recipient lines, separated by semicolons.

or Use the Address Book to add more recipients.

4. Modify the Subject line, if necessary.

5. Write your reply in the composition area.



6. Select one of the following options:

· Send Message Now ( ).

· Send Message Later ( ).

· Hold Message ( ).

· Queue to Automation Server ( ).

· Save to Folder ( )

or From the main menu, select File and one of the 
following:

· Send Now

· Send Later

· Queue To

· Hold Message

· Save to Folder…
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TeleMagic Internet Mail Folders
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All messages in TeleMagic Internet Mail will be located in one of six system folders, accessible from 
the main screen. Although the user can freely relocate messages within these folders, they will 
normally be assigned as follows:

· Inbox Contains messages you have received.

· Outbox Contains messages to be sent later.

· Sent Items Contains messages which have been sent.

· Deleted Items Contains messages which have been 
deleted.

· Undeliverable Contains messages which could not be 
delivered due to difficulties such as 
incomplete address, ISP fault, etc.

· On Hold Contains messages which are not yet 
complete.

In addition to the system folders, the user can create custom folders. 

To move a message from one file to another, click on the message and, while holding down the left 
mouse button, drag the message to the desired folder.
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To Delete a Message
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Start TeleMagic Internet Mail.

To delete a message from the main screen:

1. Click on the folder containing the message you want to 
delete.

2. Select the message you want to delete by clicking 
anywhere on the message’s description.

3.
Click on the Delete Message button. ( )

or From the Message menu, select Delete.

The message will be moved to the Deleted Items folder.

To delete a message from the Message dialog box:

Click on the Delete Message button. ( )

or From the File menu, select Delete.



The message will be moved to the Deleted Items folder.

You can set TeleMagic Internet Mail to clear the Deleted Items folder automatically whenever you open 
or close the application. If you have not selected this option, follow this procedure to permanently 
delete messages.

To permanently delete a message:

1. From the main screen, click on the Deleted Items folder.

The contents of the folder will be displayed in the 
Messages section of the screen.

2. Select the message you want to delete.

3.
Click on the Delete Message button. ( )

or From the Message menu, select Delete.

You will receive a message asking you to confirm the 
deletion.

Warning!
Once deleted from the Deleted Items folder, the message cannot be recovered.
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To Print a Message:
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You can print any message you have composed or received. You can even print messages you have 
deleted (provided you have not deleted them from the Deleted Items folder).
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Start TeleMagic Internet Mail.

To print a message from the main screen:

1. From the main screen, select the folder which contains 
the message you want to print.

The contents of the folder will be displayed in the 
Messages section of the main screen .

2. Click on the message you want to print.

The message will be displayed in the Message Body 
section of the main screen.

3.
Click the Print the Current Message button. ( )

or From the File menu, select Print.



The Print dialog box will open.

4. Select the desired printer from the drop-down list.

5. Click OK.

To print a message from the Message screen:

1. From the main screen, select the folder which contains 
the message you want to print.

The contents of the folder will be displayed in the 
Messages section of the main screen .

2. Double-click on the message you want to print.

The message will open in the Message screen.

3.
Click the Print the Current Message button. ( )

or From the File menu, select Print.

The Print dialog box will open.

4. Select the desired printer from the drop-down list.

5. Click OK.
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Message Status
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All messages in TeleMagic Internet Mail folders will have one status of a possible seven. Certain 
statuses will only be found in specific folders unless moved to another folder by the user. (The user can 
move any message into any folder regardless of status.) A message’s assigned status may be any of 
the following:

Status Meaning

The message has been received but not yet opened. 
However, the message may have been read by the user in the 
Message Body section of the screen.
The message has been opened and viewed in the Message 
screen. The user can manually change the status of any 
message in any folder to opened.
The user has replied to the author or all recipients of the 
message.
The message has been sent.

The message was sent, but could not be delivered.

The message was written, but rather than being sent was 
placed On Hold.
The message was written and placed in the queue for delivery 
at a later time.
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Attaching Files to Messages
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There are two broad categories of attachments which may accompany your messages: Files and 
Merge Documents. See the Attaching Merge Documents to Messages for more information on that 
topic. Any file type can be attached to your message, including text files, bitmaps, executables, and so 
forth. File attachments differ from Merge Document attachments in that a File attachment will not be 
modified for each recipient. A Merge Document will have all of the merge fields filled with the 
appropriate information for each recipient prior to being sent.
You can add documents in any order and combination that you like, and TeleMagic does not impose 
any limit on the number of attachments you can add to a document. However, you may encounter 
other limitations. For example, your ISP may limit the size of each e-mail message, and your recipient’s 
e-mail application may be configured to refuse messages larger than a particular size.

Warning!
TeleMagic supports filenames up to eleven characters in length (8 characters plus a 3-character 
extension, separated by a period). If you attach a file with a long filename to an e-mail message, the 
filename will be truncated to the first 8 characters. Any remaining characters, including the extension, 
will be replaced with an ellipsis.

To attach a file to a message:
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Start TeleMagic Internet Mail.

1. Open the message in the Message dialog box.



2.
Click the Add a File Attachment button. ( )

or From the Message menu, select Add Attachment….

The Open dialog box will open.

3. Select the drive containing the file to be attached from 
the Look In drop-down list.

The list of directories on the selected drive will appear in 
the dialog box’s main window.

4. Select the directory containing the file to be attached.

5. Select the desired file to be attached.

The Open dialog box will close. The Attachments 
section of the Message dialog box will open with the 
selected attachment’s file name and icon indicated.

Continue…
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Attaching_Merge_Documents_to_Messages)<<1
} Attaching Merge Documents to Messages 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Saving_Attachments_You_Have_Received)<<1} 
Saving Attachments You Have Received 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Removing_Attachments_from_Messages)<<1} 
Removing Attachments from Messages 



Attaching Merge Documents to Messages
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There are two broad categories of attachments which may accompany your messages: Files and 
Merge Documents. See the Attaching Files to Messages topic for more information on that topic. Any 
file type can be attached to your message, including text files, bitmaps, executables, and so forth. File 
attachments differ from Merge Document attachments in that a File attachment will not be modified for 
each recipient. A Merge Document will have all of the merge fields filled with the appropriate 
information for each recipient prior to being sent.
You can add documents in any order and combination that you like, and TeleMagic does not impose 
any limit on the number of attachments you can add to a document. However, you may encounter 
other limitations. For example, your ISP may limit the size of each e-mail message, and your recipient’s 
e-mail application may be configured to refuse messages larger than a particular size.

Warning!
TeleMagic supports filenames up to eleven characters in length (8 characters plus a 3-character 
extension, separated by a period). If you attach a file with a long filename to an e-mail message, the 
filename will be truncated to the first 8 characters. Any remaining characters, including the extension, 
will be replaced with an ellipsis.

To attach a merge document to a message:
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Start TeleMagic Internet Mail.

1. Open the message in the Message dialog box.

2. Click on the Add a Merge Document as an Attachment 



button. ( )

The Select Document dialog box will open.

3. Open the directory containing the merge document you 
want to attach by double-clicking on the associated icon.

The documents available in the selected directory will be 
listed below the directory.

4. Select the merge document you want to attach.

5. Click OK.

The Select Document dialog box will close. The 
Attachments section of the Message dialog box will 
open with the selected document’s file name and icon 
indicated. 

Continue…
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Removing Attachments from Messages
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There are two ways to remove an attachment from your message. Both methods apply to any type or 
category of attachment.
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Start TeleMagic Internet Mail.

To remove an attachment from a message:

1. Open the message in the Message dialog box.

2. Click on the attachment you want to remove.

The attachment and its icon will be highlighted.

3. Press DELETE.

The attachment will be removed from the message.

To remove an attachment from a message (alternate method):

1. Open the message in the Message dialog box.

2. Right-click on the attachment you want to remove.



The Attachment Maintenance menu will open. 

3. Click Remove.

The attachment will be removed from the message.

Continue…
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Saving Attachments You Have Received
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To save an attachment:

{ewc 
rhgbtn
32.dll, 
BlueS
kyHel
pButto
n, 
g<pro
cedup.
bmp|
proce
ddn.B
MP<J
umpId
(TMM
AIL.H
LP>se
condï
¿½TM
MAIL_
Startin
g_Tele
Magic
_Inter
net_M
ail)<<
1}

Open TeleMagic Internet Mail.

1. Open the message in the Message dialog box.

2. Right-click on the attachment you want to remove.

The Attachment Maintenance menu will open.

3. Click Save As….

The Save Message dialog box will open.

4. Select the directory you want to save the attachment in 
from the Save in drop-down list.

5. Click Save.

The attachment will be saved.



Continue…
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Sending Mail from the Local Queue
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If you have created a pending e-mail message (one you have written, but not yet sent), the e-mail 
will have been placed in your Outbox awaiting further instructions. This is useful, for example, if 
you want to send a message when network or ISP traffic is lighter.

To send mail from the local queue:
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Open TeleMagic Internet Mail.

1. From the Folders section of the main screen, select the 
Outbox.

The contents of the Outbox will be displayed in the 
Messages section of the main screen.

2. Select the queued message(s) you want to send.

3.
Click the Send Messages button. ( )

The message(s) will be sent to the recipient(s) and 
moved to the Sent folder.
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On Hold Messages
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If you have created a pending e-mail message (one you have written, but not sent), the e-mail will 
have been placed in your On Hold mailbox awaiting further instructions. This is useful, for 
example, if you want to start drafting a message, but hold it pending further information. This is 
the only way to handle a message which has a blank Subject line.

To send a pending message:
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Open TeleMagic Internet Mail.

1. From the Folders section of the main screen, select the 
On Hold box.

The contents of the On Hold box will be displayed in the 
Messages section of the main screen.

2. Open the pending message you want to complete and 
send in the Message dialog box.

3. Complete any changes or additions to the message.

4. Choose from one of the following options:

· Click the Send Messages button ( ) to 
send the message immediately.



· Click the Send Message Later button ( ) to 
change the message status to Queued Local 
and move it to the Outbox.

· Click the Hold Message button ( ) to save 
changes and leave the message in the On 
Hold folder with the Pending status.

· Exit the Message dialog box to leave the 
message in the On Hold box without changes 
to content or status. (You will receive a 
message to confirm this option.)
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Forwarding Messages
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Sometimes you will receive messages which will be of interest to others. You can edit and forward 
these messages in much the same way as you would compose and send an original message.

To forward messages to additional recipients:
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Open TeleMagic Internet Mail.

1. Select the folder containing the message you want to 
forward.

The list of available messages will be displayed in the 
Messages section of the screen.

2. Click anywhere on the message line of the message you 
want to forward.

The selected message will be highlighted.

3.
Click the Forward Message button. ( )

or From the Message menu, select Forward.

The Message dialog box will open.
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5. Edit the message, if necessary.

6. Select from one of the following:

· Click the Send Message Now button ( ) to 
send the message.

· Click the Send Message Later button ( ) to 
send the message to the Outbox folder.

· Click the Hold Message button ( ) to send the 
message to the On Hold folder.

· Click the Queue to Automation Server button (

) to send the message to the automation 
server queue.

· Click the Save Message to Folder button ( ) 
to save the message in one of the TeleMagic 
Internet Mail folders.)



Continue…
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Marking Messages
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You may want to mark certain messages for special handling. TeleMagic Internet Mail allows you to 
mark some messages to distinguish them from others. When messages are marked, the list of 
messages in any folder can be arranged according to the marked status.

To mark a message:
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Open TeleMagic Internet Mail.

1. Select the folder which contains the message(s) you 
want to mark.

2. Click anywhere on the message line of the message you 
want to mark.

3. From the Message menu, select Mark.

A check mark will appear next to the item.

Repeat steps 2 and 3 for any additional messages you 
want to mark.
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Unmarking Messages
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To unmark a message:
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Open TeleMagic Internet Mail.

1. Select the folder which contains the message(s) you 
want to unmark.

2. Click anywhere on the message line of the message you 
want to unmark.

3. From the Message menu, select Unmark.

The check mark next to the item will disappear.

Repeat steps 2 and 3 for any additional messages you 
want to unmark.

Continue…
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Marking_Messages)<<1} Marking Messages 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Arranging_Messages)<<1} Arranging Messages 



Arranging Messages
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You can determine the order in which your messages are displayed in the Messages section of the 
TeleMagic Internet Mail main screen. Message order can be set according to any of the following 
criteria:

· Status
· Marked
· Linked
· To or From (depending on folder)
· Subject
· Date Received

To arrange the list of messages displayed according to a particular criterion, click on the corresponding 
button at the top of the column containing the field. The list will be arranged in natural order for the type 
of information in the column. (Alphabetical or sequential). To reverse the order, click on the button a 
second time.
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Custom Folders
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Some users may benefit from special purpose folders in addition to the standard set of system folders 
provided with TeleMagic Internet Mail.

To create a new folder:
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Open TeleMagic Internet Mail.

1. From the File menu, select New Folder….

The Add Folder dialog box will open.

2. Enter the name for the new folder in the Folder Name: 
field.

3. Click OK.

The new folder will appear in the Folders section of the 
main screen.
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Removing Folders
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If you have added folders to your TeleMagic Internet Mail system which are no longer needed, you can 
remove them. You cannot remove system folders.

To remove a folder:
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Open TeleMagic Internet Mail.

1. Click on the folder you want to remove.

The contents of the folder will be displayed in the 
Messages section.

2. From the File menu, select Remove Folder.

The folder will be removed.
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Moving Messages to Other Folders
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TeleMagic Internet Mail has six standard folders and the user has the option to add more folders . The 
standard system folders were designed to contain messages which met certain criteria, but you can 
freely move messages into any folder you want.

To move a message to another folder using drag-and-drop:
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Open TeleMagic Internet Mail.

1. Click on the folder containing the message you want to 
move.

The messages contained in the selected folder will be 
displayed in the Message area of the main screen.

2. Position the mouse cursor anywhere on the message 
line.

3. Click and hold the left mouse button.

The message line will become highlighted.

4. Drag the message line to the vicinity of the destination 
folder.

The folder will become highlighted.

5. Release the mouse button.



The selected file will be moved from the original folder 
and placed in the target folder.

To move a file to another folder using the menu:
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Open TeleMagic Internet Mail.

1. Click on the folder containing the message you want to 
move.

The messages contained in the selected folder will be 
displayed in the Message area of the main screen.

2. Click on the message line you want to relocate.

The message will become highlighted.

3. From the File menu, select Move to Folder….

The Move to Folder dialog box will open.

4. Click on the destination folder.

The selected folder will become highlighted.

5. Click OK.

The message will be moved and the Move to Folder 
dialog box will close.
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Copying Messages to Other Folders
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Sometimes you may want a message to be in more than one folder. For example, you may compose a 
message for one group of recipients that you want to send later. You would probably store this 
message in the Outbox until you were ready to send. Meanwhile, you may want to keep a copy of the 
message in the On Hold folder so you can modify it and send to another group of recipients once you 
have begun receiving responses to the first copy.

To copy a message to another folder:
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Open TeleMagic Internet Mail.

1. Click on the folder containing the message you want to 
copy.

The selected folder will become highlighted.

2. Click anywhere on the message line for the message you 
want to copy.

The selected message will become highlighted.

3. From the File menu, select Copy to Folder….

The Copy to Folder dialog box will open.

4. Click on the folder you want to receive the copy of the 
file.



5. Click OK.

A copy of the selected file will be placed in the target 
folder.
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The TeleMagic Internet Mail Main Screen
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The main screen of TeleMagic Internet Mail is arranged in sections. Each of these sections serves a 
specific purpose. Since different users have different approaches to managing their electronic 
communications, some of these sections may be irrelevant to some users.

To change the appearance of the main screen:
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Open TeleMagic Internet Mail.

1. Select View from the main menu.

The View menu will open.

If a particular section is currently being displayed as part 
of the main screen, there will be a check mark next to the 
corresponding item in the View menu. Clicking on a 
menu item will cause the check to toggle off and on.

2. Click on the menu item corresponding to the section you 



want to add or remove from display.
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The TagLine
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A TagLine is an optional message you can compose once and insert in all of your messages. TagLines 
are generally used as standard closures for messages and can be as long as you feel necessary. The 
TagLine can either be inserted automatically in each of your messages, or manually.

To create or edit your TagLine:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select TagLine.

The Edit Your TagLine dialog box will open.

2. Compose your TagLine in the text window.

3. If you want the TagLine to appear automatically in each 
of your messages, mark the Automatically insert 
TagLine into new messages checkbox.

4. Click OK.
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Inserting a TagLine in a Message
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If you have chosen not to automatically include your TagLine in each message, you can enter it 
manually from the Message window.

To insert your TagLine in a message:
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Open a new message, or open an existing message for 
editing.

1. Place your cursor where you want the TagLine to start.

2. From the Tools menu, select Insert TagLine.

The TagLine will be placed in the message beginning at 
the point where your cursor was placed in step 1.
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TeleMagic Internet Mail Preferences and Options
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TeleMagic Internet Mail provides you with a wide variety of choices in how to configure your mail 
system. You can change the appearance of the Main Screen, compose a TagLine, and create new 
folders, as well as many other options. The following topics are procedures which will step you through 
the process of setting up Internet Mail to fit your needs:
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General Preferences
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The General Preferences tab provides options for you to determine what happens to deleted 
messages, how the Outbox is handled, whether your messages are automatically spell checked, and 
what is included in your replies.

To access General Preferences:
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Open TeleMagic Internet Mail.

From the Tools menu, select Options….

The Preferences dialog box will open.

The following options are available:

· Send deleted mail to Deleted Items folder

Marking this checkbox will result in messages 
being moved to the Deleted Items folder upon 
deletion. If this checkbox is marked, the Empty 
Deleted Items radio buttons will become 
available.

· Empty Deleted Items

Select the radio button to empty your Deleted 



Items folder:

· at start up

· on exit

· never, I will delete them manually

· Warn me before permanently deleting mail

Mark this checkbox to receive a message when 
you are about to delete a message with no 
potential for recovery.

Warning!
If you have selected to empty deleted items on start up or exit, there will be no warning before mail is 
permanently deleted.

· Include original message in reply

Mark this checkbox to automatically append the 
message you are answering to your reply. Each 
line of the original message will be prefaced 
with ‘>’.

· Include yourself when replying to all

Mark this checkbox if you want to receive a 
copy of your reply when you respond to a 
message using the Reply to All option.

· Send mail as Rich Text by default

Mark this checkbox if you normally want your 
messages sent with all text formatting. If your 
mail is not sent as Rich Text, the message 
received will be in default font and formatting. 
Some mail readers do not recognize Rich Text 
Formatting. If a message in Rich Text Format is 
read with one of these applications, it will 
contain spurious character strings which make 
reading difficult.

· Store mail encrypted

Mark this checkbox to store messages in a 
format which cannot be read without TeleMagic.

· Attachment Directory

Click this button to open the Select Directory 
dialog box and browse for the directory where 
attachments to incoming mail should be stored. 
You can also enter the path directly in the field 
to the right of the button.

· Mailbox Name

Enter the name of the mailbox in this field. The 
name will appear in the title bar of the main 
screen.



· Password

Enter a password in this field to establish a 
password for TeleMagic Internet Mail that differs 
from your TeleMagic password. If you have a 
password here, you will need to enter it even 
when launching TeleMagic Internet Mail from 
within TeleMagic.

· Make TeleMagic Internet Mail my default mail 
client

Mark this checkbox to make TeleMagic Internet 
Mail the default mail client. Your default mail 
client will be launched whenever an application 
calls for a mail editor. For example, if you are 
browsing a website and select a Send Mail 
hotspot, your default mail client is launched. In 
TeleMagic you can establish e-mail fields. When 
you click the icon for one of these fields, your 
default mail client will be launched.

When satisfied with your General Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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Display Preferences
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Display preferences allow you to determine the appearance of your Internet Mail main screen, and the 
font that will be used in your messages.

To access Display Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Display tab.

The Display Preferences page will be displayed.

The following options are available:

· Show Toolbar

The Toolbar contains the graphical buttons. This 
preference is marked by default. If you do not 
want the toolbar displayed in your main screen, 
unmark this checkbox.

· Show Status Bar



The Status Bar, located at the bottom of the 
main screen, indicates the currently selected 
folder and how many messages it contains. 
Unmark this checkbox if you do not want to 
have this information displayed on your main 
screen.

· Show Folders

The Folders section, on the left side of the main 
screen, displays all of your system and custom 
folders. Unmark this checkbox if you do not 
want to view the folders.

· Show Message Body

The Message Body section contains the text of 
the message currently highlighted in the 
Message section. Unmark this checkbox if you 
do not want message text to be displayed.

You also have the option of changing the font used to display your messages.

To change the font:

1. Click on the Font button.

The Font dialog box will open.

You can set the following options:

· Font

· Font Style

Regular

Bold

Italic

Bold Italic

· Size

· Effects

Strikeout

Underline

Color

· Script

A sample of the chosen font and options will be displayed in the Sample window.

To Customize the Display Configuration:

· Use default display configuration



Mark this checkbox to retain the defaults for 
how items are displayed on the screen. When 
this is not marked, you will be able to specify 
how items are displayed based on status.

Each status is listed on the left side of this section of the 
page. To the right of each, you can select the color and 
font style to be applied to each status. These selections 
affect the messages entry in the From, Subject, and Date 
Received columns when viewing the Inbox or Deleted 
Items folders, the To, From, and Subject columns when 
viewing the Deleted Items folder, and the To, Subject, and 
Last Modified column when viewing any other folder. As 
you change the settings, the name of the status will be 
displayed with the selected effects as an example. The 
following properties can be defined for each status:

Color Select the font color from the drop-
down list for each status.

Bold Mark this checkbox for each status 
that should appear in boldface.

Italic Mark this checkbox for each status 
that should appear in italics.

Underline Mark this checkbox for each status 
that should appear underlined.

Strikethrough Mark this checkbox for each status 
that should use the strikethrough 
style.

When satisfied with your Display Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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Server Preferences allow you to add multiple accounts from which to send and receive e-mail, and 
configure MAPI options .

To access Server Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Servers tab.

The Server Preferences page will be displayed.

To add a new account:

1. Click New.

The Internet Account Wizard will open.

2. Enter a description for this account in the Description: 
field.

3. If you would like to make this your default account, mark 



the Make this my default account checkbox.

4. Click Next.

5. In the I am known as: field, enter your name. This is the 
name that a recipient will see in the From field when you 
send e-mail.

6. Enter your e-mail address in the E-mail Address: field.

7. Enter the outgoing mail server in the SMTP: field.
Warning!
Do not change the value in the SMTP Port: field unless specifically instructed to do so by your system 
administrator.

8. Click Next.

9. Enter the incoming mail server in the POP3 Server: field.

10. Enter the user name for the mail server in the User Name: 
field.

11. Enter the password used with the mail server in the 
Password: field.

Warning!
Do not change the value in the POP3 Port: field unless specifically instructed to do so by your system 
administrator.

12. Mark always retrieve mail from this account to

13. Mark Delete messages from server to remove messages 
from the mail server after downloading.

14. Click Next.

15. Select Use Dial-up Networking/RAS to use an established 
Dial-up connection.

or Select Connect through my Local Area Network (LAN), then 
skip to step 19.

16. If you selected Use Dial-up Networking/RAS, select the 
connection you want to use from the drop-down list.

17. Enter the user name associated with this Dial-up 
connection in the Username: field.

18. Enter the password associated with the user name 
entered in step 17 in the Password: field.

19. Click Finish.

The following MAPI options are available:

· Logon to MAPI

Select the radio button that indicates your 
preference for logging on to MAPI. You can be 



prompted before logging on, always log on, or 
never log on.

· Mailbox Name

Enter your MAPI mailbox name in this field. If 
this is blank, you will be prompted for a mailbox 
when logging on to MAPI.

· Password

Enter your MAPI password in this field. If this is 
blank, you will be prompted for a password 
when logging on to MAPI.

When satisfied with your Server Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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Delivery Preferences
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Delivery Preferences allow you to determine how often your application queries your ISP for Internet e-
mail and how you are notified of new mail.

To access Delivery Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Delivery tab.

The Delivery Preferences page will be displayed.

The following options are available:

· Check for message every

Mark this checkbox to automatically query for 
mail. TeleMagic Internet Mail will dial up your 
ISP if you are not online when the specified 
period has elapsed.

· minutes

Enter the number of minutes you want to elapse 



before automatically checking for mail. If Check 
for message every is not marked, this entry is 
ignored.

· Don’t download messages greater than

Mark this checkbox to restrict the size of 
messages that you want to receive. If you mark 
this checkbox, enter the maximum size, in 
kilobytes, that you want to receive in the K field. 
You can either enter the amount directly, or you 
can use the spinner arrows..

When new mail is received, notify me:

· Never

You will not be notified of new mail.

· Visually

When new mail is received, a message will 
appear informing you.

· Audibly

When this radio button is selected, the text field 
will become available. Enter the path and file 
name of a WAV file in the field, or click the 
ellipsis (…) button to locate a file. When new 
mail is received, the selected WAV file will be 
played.

· Visually and Audibly

When this radio button is selected, the text field 
will become available. Enter the path and file 
name of a WAV file in the field, or click the 
ellipsis (…) button to locate a file. When new 
mail is received, a message will appear and the 
selected WAV file will be played.

When satisfied with your Delivery Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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To access Spelling Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Spelling tab.

The Spelling Preferences page will be displayed.

The following options are available:

· Automatically spell check messages when 
sending or queuing

Mark this checkbox to perform a spell check on 
each message before sending it.

· Ignore Uppercase words

Mark this checkbox to ignore any words that are 
entirely uppercase when performing the spell 
check.



· Ignore words containing numbers

Mark this checkbox to ignore any words which 
contain at least one number when performing 
the spell check.

· Ignore HTML tags

Mark this checkbox to ignore any words in 
HTML tag format when performing the spell 
check.

· Ignore URLs and e-mail addresses

Mark this checkbox to ignore any words in URL 
or e-mail address format when performing the 
spell check.

· Check for repeated words

Mark this checkbox to alert on the second 
consecutive occurrence of the same word when 
performing the spell check.

· Auto-Suggest

Mark this checkbox to have the spell checker 
offer a list of suggested spellings for misspelled 
words.

· Recheck replaced words

When the spell checker finds a word that it does 
not recognize, it gives you the opportunity to 
enter another spelling. Mark this checkbox to 
perform a spell check on words entered in this 
way. Words replaced from the suggested list 
are not rechecked.

When satisfied with your Spelling Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.



TeleMagic Preferences
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To access TeleMagic Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the TeleMagic tab.

The TeleMagic Preferences page will be displayed.

The following options are available:

· Log on to TeleMagic

Select the radio button indicating your 
preference for logging on to TeleMagic. You can 
choose to be prompted before logging on, 
always log on, or never log on. You must be 
logged on to TeleMagic in order to use certain 
features, like linking and displaying linked 
information. You can be logged on to TeleMagic 
without it being open. If you are logged on with 
TeleMagic closed, you will be able to link 
messages to contacts using the Advanced 



Search feature and display contact information, 
but you will not be able to Link to Current 
Contact. If you choose Never, the remaining 
options on this page will have no effect.

· Enter the location of your TeleMagic installation

Enter the path to TeleMagic. You can enter the 
path directly, or you can click the Modify button 
and browse for the Installation.

· UserID

Enter your TeleMagic user ID in this field.

· Password

Enter your TeleMagic password in this field.

· When using Goto based on the e-mail address, 
look for the contact in

Select the radio button indicating how you want 
to search for contacts when using Goto. You 
can choose to check only the current database, 
all databases, or check the current database 
and be prompted before checking other 
databases.

· Automatically link incoming mail

Mark this checkbox to have TeleMagic Internet 
Mail search your databases for contacts with e-
mail addresses matching the sender’s address 
on incoming mail and linking the message to 
that contact. You must have the E-mail key field 
established in each database with which you 
want to use this feature.

· Set Search Order

This button becomes available when you have 
chosen to automatically link incoming mail. Click 
this button to open the Select Database dialog 
box and select the databases to be searched, 
and in what order.

· Stamp Notepad

Mark this checkbox to mark the notepad of the 
linked contact and record that a message was 
sent.

· Create Activity

Mark this checkbox to create an activity based 
when a linked message is sent.

When satisfied with your TeleMagic Preferences, click OK to accept the preferences and close the 
Preferences dialog box.



or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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Automation Server Preferences allow you to determine how messages are handled when they are 
queued to the Automation Server and what happens when you send a linked message.

To access Automation Server Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Automation Server tab.

The Automation Server Preferences page will be 
displayed.

To add a new Automation Server account:

1. Click New.

The Automation Server Mail Account Setup dialog box 
will open.

2. Enter a description for this account in the Description: 
field.



3. Enter the POP3 (receive mail) server name in the Host 
Name: field.

4. Enter the user name recognized by the mail service (ISP) 
to access this account in the User Name: field.

5. Enter the password used to access this account on the 
mail service in the Password: field.

6. The Port: value is preset to 110. Do not change this 
setting unless instructed to do so by your ISP.

7. Mark the Delete messages from the server checkbox to 
delete messages on the mail service after they have 
been retrieved. If you do not mark this checkbox, you will 
continue to retrieve messages that you have deleted 
locally until they are deleted from the server.

Click OK.

The following options are available:

· Send e-mail notification of failure

Mark this checkbox to have the Automation 
Server send you an e-mail message whenever 
one of your messages that was sent via the 
Automation Server fails.

· Fail on Invalid Merge Field

Mark this checkbox to fail any message if the 
attached merge document contains an invalid 
field.

· Stamp Notepad

Mark this checkbox to stamp the notepad of 
linked contacts when a message to them is sent 
via the Automation Server.

· Create Activity

Mark this checkbox to create an activity based 
on the message when sent via the Automation 
Server.

When satisfied with your Automation Server preferences, click OK to accept the preferences and close 
the Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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Filter Preferences
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Mail filters are used to automatically direct incoming mail to folders other than the Inbox, forward them 
to other recipients, or delete them based on the presence of specified text in selected fields of the 
message being filtered.

To access Filter Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Filters tab.

The Filter Preferences page will be displayed.

To add a new filter:

1. Click New Filter.

The Mail Filter Properties dialog box will open.

2. Enter a description for this filter in the Description: field.



3. Enter the text that will cause the action of the filter to be 
executed in the When receiving mail containing text: field.

4. Mark the Case Sensitive checkbox to require that the case 
of the text be considered when matching the test criterion 
to the contents of the message.

5. Mark the fields where the test criterion can    be found to 
cause the action of the filter to be executed. You can 
select any combination of the To, CC, From, Subject, and 
Message Body fields.

6. Select the radio button that describes the action to be 
taken when the test criterion is met. You can choose to 
move the message to a particular folder, delete the 
message, redirect the message to another recipient, or 
forward the message to another recipient. If you choose 
to redirect or forward the message to another recipient, 
enter their e-mail address in the text field. If you choose 
to redirect the message, the message will not appear in 
any of your folders.

7. The Select Folder button becomes available if you choose 
to move the message to a folder. Click this button to 
open the Select Folder dialog box and choose the folder 
to send the message to.

8. Click OK.

When satisfied with your Filter Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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To access Address Preferences:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select Options….

The Preferences dialog box will open.

2. Click on the Addresses tab.

The Address Preferences page will be displayed.

Select the radio button indicating your preference as to 
how names are displayed. This setting affects the 
Address Book and, indirectly, the address lines on new 
messages. This setting can be overridden on individual 
cards. Changing this setting does not affect cards that 
are already in the Address Book.

When satisfied with your Address Preferences, click OK to accept the preferences and close the 
Preferences dialog box.
or
Click Apply to accept the changes, keep the Preferences dialog box open, and continue with changes 
in other areas.
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The Internet Address Book
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TeleMagic Internet Mail provides you with several means of managing e-mail addresses. While the 
TeleMagic User’s page of the Select Recipients dialog box is maintained automatically by TeleMagic, 
and the MAPI page is interfaced from your MAPI application, the Address Book provides you with 
complete flexibility as to its content. As with the Select Recipients dialog box, you can easily address 
your messages by simply selecting the Internet Address Book and clicking on the name of the intended 
recipient or recipients. In addition, you can define groups of recipients to whom you are likely to send 
mail on a regular basis. These groups are selected in the same manner as individual recipients.

Continue…
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Maintaining Your Internet Address Book 
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Using This Help System
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Getting more information
TeleMagic’s help system has been designed to provide you with all of the information you need 
without excessive clutter. To accomplish this, all procedures have amplifying information attached 
to a set of graphical controls as well as traditional help system jumps and hotspots. Access 
amplifying information wherever you see the following icons:

 This is a Note icon. Click on it to see a note.

 This is a Hint icon. Click on it to see a hint.

Sometimes there will be a General Note button in the upper section of the topic:
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<NOTEUP01.BMP|
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tem)<<1} This is the General Note button. Click on it for general notes.

Navigating the Help System
Moving from topic to topic in this Help System can be accomplished several ways in addition to 
using the standard Help Topics and Back buttons. The top of each topic will always contain this 
button:
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stem)<<1} This is the Related Topics button. Click on it to see related topics.

Within the body of the topic there may be hotspots , which will be green and underlined. Click on 
the hotspot to open the topic.

There may also be popup hotspots . You can tell a popup hotspot from a regular hotspot by the 
dotted underline. Click on the popup hotspot for more information.

At the end of each topic will be one of two kinds of buttons:
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<contup01.bmp|
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Click on this button to proceed to the one, preselected, follow-on topic.

or

Choose one of the following topics:
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Continue to Topic buttons, as above, are always associated with a jump hotspot. You can click on 



either the button or the hotspot to proceed to the indicated topic.
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Maintaining Your Internet Address Book
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<RELAUP01.BMP|RELADN01.BMP<Klink(Mailï¿½ ï¿½ 
ï¿½ )<<1}

The Internet Address Book provides you with the ability to maintain a private set of e-mail addresses. 
Use this feature to help stay in touch with individuals who are not included in your TeleMagic or MAPI 
address books.

To make an entry in the Internet Address Book:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select TeleMagic Address 
Book….

The Address Book will open.

2. From the File menu, select New, Card….

The Card Properties dialog box will open to the Personal 
tab.

3. Enter the following information in the fields provided:

· First, Middle, and Last name.

The contact’s full name.

· Display as

The name you want displayed in the 



Name column in the Address Book and 
what you want displayed in the address 
field of messages.

· E-mail address

The contact’s e-mail address.

All remaining steps are optional. You can click OK at any time to save whatever you have entered 
so far.

4. Click on the Home tab.

The Home information entry screen will be displayed.

5. Enter the following information in the fields provided:

· Address

The contact’s street address.

· City

· State

· Zip

ZIP or Postal code

· Country

· Phone

· Fax

· Pager

6. Click on the Business tab.

The Business information entry screen will be displayed.

7. Enter the following information in the fields provided:

· Name

The name of the contact’s business or 
organization.

· Address

The street address of the contact'

· City

· State

· Zip

ZIP or Postal code

· Country



· Phone

· Fax

· Pager

8. Click the Notes tab.

The Notes screen will be displayed.

9. Enter any other information you want to keep available 
concerning this contact.

10. Click OK.

The Card Properties dialog box will close. You will be 
returned to the Address Book .
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To Create a Group in the Internet Address Book
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By creating groups in your Address Book you will save time by eliminating the need to select individual 
recipients. You can group individuals according to any criterion you like. You may, for example, create a 
group for each of the firms or organizations you regularly deal with.
An individual can be included in more than one group. Therefore, in addition to being in a group for 
their company, an individual could also be in a group of all suppliers, all customers in Europe, or all 
purchasing agents.

To create a group:
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Open TeleMagic Internet Mail.

1. From the Tools menu, select TeleMagic Address 
Book….

The Address Book will open.

2. From the File menu, select New, Group….

The Group Properties dialog box will open.

3. Enter the name of the group in the Group Name field.

4. Click on the user you want to add to the group.

The selected user will become highlighted.



5. Click Add.

The selected individual will be removed from the list of 
Available recipients and added to the Members list.

6. Repeat steps 4 and 5 until you are satisfied.

7. Click OK.

Double-click on Personal Addresses. The new group 
will appear under the Personal Addresses icon.
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To Delete an Individual or Group from the Address Book
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Open TeleMagic Internet Mail.

1. From the Tools menu, select TeleMagic Address 
Book….

The Address Book will open.

2. Click on the individual or group you want to delete.

The selected entry will be highlighted.

3. From the File menu, select Delete.

You will receive a message confirming the deletion.

4. Click Yes to delete the item.

The item will be removed from the list.
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Opening TeleMagic Internet Mail for the First Time
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The first time you open TeleMagic Internet Mail, you will need to provide some information for the initial 
configuration. You can edit any of this information later, as required. You can open TeleMagic for the 
first time while in TeleMagic, or independently of TeleMagic. The user must exist in TeleMagic before 
the mail account can be established.

To Open Internet Mail for the First Time (External to TeleMagic):

1. From the taskbar, select Start, Run.

The Run dialog box will open.

2. Enter the file name with complete path in the text 
window.

or Click Browse and use the Browse dialog box to locate 
the file.

3. Click OK.

The TeleMagic E-mail login screen and Mail Login dialog 
box will open.

4. Enter your user ID in the Mailbox: field.

5. Enter your TeleMagic password in the Password: field.

6. Click OK.

A message will open asking if you would like to create a 
new mailbox.

7. Click Yes.

The Mailbox Setup Wizard will launch.

8. A location to store your mail will be offered. You can 
change this by typing a new path in the field, or you can 
click Modify and browse for the location. If you enter a 
directory that does not exist, you will be prompted to 
confirm that you want to create a new directory.

9. Click Next.

10. Enter the name you want to appear in the From field of 
your messages in the I am known as field.

11. Enter the password you want to use to access TeleMagic 
Internet Mail in the Password field. Re-enter the 
password in the Verify Password field. These two 
entries must match exactly to proceed.

12. Click Next.

13. Select the radio button indicating how you would like to 
log on to TeleMagic. You can choose to log on to 
TeleMagic whenever you open Internet Mail, to be 



prompted to log on, or not to log on.

14. The location of your TeleMagic installation will be offered 
in the Enter the location of your TeleMagic 
installation: field. Correct this if necessary by entering 
the correct path, or by clicking Modify and browsing for 
the installation.

15. Enter your TeleMagic User ID in the UserID: field.

16. Enter your TeleMagic Password in the Password: field.

17. Click Finish.

TeleMagic Internet Mail will open.

Initial setup is complete. You will be able to exchange mail with other TeleMagic users, but you 
must establish at least one server to be able to exchange mail through the Internet. To set up a 
server, see Server Preferences.

To Open Internet Mail for the First Time (From TeleMagic):
See the topic Starting TeleMagic Internet Mail. You will be able to exchange mail with other 
TeleMagic users, but you must establish at least one server to be able to exchange mail through 
the Internet. To set up a server, see Server Preferences.



To Address a Message to a Contact
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Preliminary To use the E-mail field fully, you must first add a field to your database to hold e-mail 
addresses. Contacts must have a valid e-mail address in this field to be addressed 
using any of these procedures. Then you must identify that field as your E-mail Key 
Field. To open a new message with the current contact as the addressee, you must 
have an E-mail field in your database with the contact’s e-mail address and you must 
have a default mail client established in Windows. You can establish TeleMagic Internet 
Mail as your default mail client , or you can establish another application. To establish 
another application, refer to that applications documentation.

To Address a Message to the Current Contact:

Click on the icon next to the E-mail field. 

Your default mail client will open with a new message 
started. The message will be addressed to the selected 
contact.

To Address a Message Using Contact Search:

1. Open a new message as described in Composing and 
Sending a Message.

2. Click on the To: button to the left of the address field.

The Select Recipients dialog box will open.

3. Click the Contacts tab.

The Contacts page will open.

4. Click To:, CC:, or BCC:.

The Advanced Contact Search dialog box will open.

5. Enter the search criterion in the Search for: field.

6. Select the database to be searched from the Database: 
drop-down list.

7. Select the level to be searched from the Level: drop-
down list.

8. Select the index to be used for the search from the Index: 
drop-down list. The first field of the selected index’s 
expression must contain the search criterion entered in 
step 5.

example:

If you want to search the Documentation database for a 
contact’s first name, you would enter the contact’s first 
name in step 5, select Documentation Database in step 6, 



select Level in step 7, and select Contact First Name in 
step 8.

9. Click Search.

The Advanced Contact Search dialog box will close. The 
first contact meeting the search criterion will be entered 
in the field associated with the button you clicked in step 
4. If no match is found, a message will appear. You will 
have the option of searching the database using Browse.

Repeat steps 4 through 9 to add more recipients to the 
message.

10. When all recipients have been added, click OK.

The Select Recipients dialog box will close. The 
message will be addressed to the selected recipients.

To Address a Message Using Browse:

1. Open a new message as described in Composing and 
Sending a Message.

2. Click on the To: button to the left of the address field.

The Select Recipients dialog box will open.

3. Click the Contacts tab.

The Contacts page will open.

4. Click To:, CC:, or BCC:.

The Advanced Contact Search dialog box will open.

5. Select the database to be searched from the Database: 
drop-down list.

6. Select the level to be searched from the Level: drop-
down list.

7. Select an index from the Index: drop-down list. The 
selected index will determine the order in which the 
contacts are displayed.

8. Click Browse.

The Select a Contact browse window will open.

9. Scroll through the list until you have found the desired 
contact.

10. Highlight the contact by highlighting one of the fields in 
the contact record.

11. Click Select.

The Select a Contact browse window and the Advanced 
Contact Search dialog box will close. The highlighted 



contact will be added to the field indicated in step 4.

Repeat steps 4 through 11 to add more contacts.

12. When all addressees have been added, Click OK.

The Select Recipients dialog box will close. The 
message will be addressed to the selected contacts.

Continue…
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Attaching_Files_to_Messages)<<1} Attaching 
Files to Messages 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Attaching_Merge_Documents_to_Messages)<<1
} Attaching Merge Documents to Messages 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(tmmail.hlpï¿½TMMAIL_Composing_and_Sending_a_Message)<<1} 
Composing and Sending a Message 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(tmmail.hlpï¿½TMMAIL_Using_the_Contacts_with_Merge_Option_Featu
re)<<1} Using the Contacts with Merge Option Feature 
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(tmmail.hlpï¿½TMMAIL_To_Address_a_Message_to_Another_User)<<1} 
To Address a Message to Another User 



To Address a Message to Another User
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1. Open a new message as described in Composing and 
Sending a Message.

2. Enter the user’s ID in the To: field. The ID must be 
enclosed in angle brackets (<>). Add additional recipients 
as required separating each with a semicolon (;). 
Proceed to step 7.

or Click on the To: button to the left of the address field.

The Select Recipients dialog box will open.

3. Click TeleMagic Users.

All users in the current installation will be listed in the 
field on the left.

4. Highlight the name of the user who is to receive the 
message and click To:, CC:, or BCC:. All messages 
must have at least one entry in the To: field to be sent.

The User name will appear in the selected field.

5. Repeat step 4 as necessary to address the message to 
all recipients.

6. Click OK.

The Select Recipients dialog box will close 

7. Compose and send the message as described in 
Composing and Sending a Message.
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Linking Messages to Contacts
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By linking an e-mail message to a contact, you will be able to quickly retrieve contact information 
and go directly to the contact from TeleMagic Internet Mail, paste contact information into the 
message, and attach merge documents to the message. You must be logged into TeleMagic 
Enterprise to use this feature.

To link an e-mail message to the current contact:

1. Open TeleMagic to the contact that you want to link the 
message to.

2. Open the message for editing, or create a new message.

3. Click on the Link Message to Contact button .

The Link Contact dialog box will open.

4. Mark the Current Contact radio button to link the 
message to the current contact.

The message will be linked to the selected contact.

To link an e-mail message to a contact in the current database, other than 
the current contact:

1. Open the message for editing, or create a new message.

2. Click on the Link Message to Contact button .

The Link Contact dialog box will open.

3. Select the Other Contact radio button.

The Search and Browse options will become available.

4. Enter the information to be searched for in the Search 
my contacts for: field and click Search.

The message will be linked to the first contact matching 
the search criterion.

or Click Browse to search for the contact using a Browse 
screen. Click on the desired record to link the message.

To link an e-mail message to a contact in another database, or when 
TeleMagic is closed, using Search:

1. Open the message for editing, or create a new message.

2. Click on the Link Message to Contact button .

The Link Contact dialog box will open.



3. Mark the Other Contact radio button.

The Search and Browse options will become available.

4. Click Advanced Search.

The Advanced Search dialog box will open.

5. Select the database containing the record from the 
Database drop-down list.

6. Select the level of the database containing the record 
from the Level drop-down list.

7. Select the index to be used for the search from the Index 
drop-down list.

8. Enter the information to be searched for in the Search 
for: field.

9. Click Search.

The message will be linked to the first record in the 
specified database and level which meets the search 
criterion. If no matching record is found, you will be given 
the opportunity to browse for the record.

To link an e-mail message to a contact in another database using Browse:

1. Open the message for editing, or create a new message.

2. Click on the Link Message to Contact button .

The Link Contact dialog box will open.

3. Mark the Other Contact radio button.

The Search and Browse options will become available.

4. Click Advanced Search.

The Advanced Search dialog box will open.

5. Click Browse.

A browse screen will open. Click on the record to which 
you want to link the message. The message will be 
linked to the selected record.
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Linking Incoming Messages
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TeleMagic Internet Mail can search your databases for contacts with e-mail addresses that match 
the From addresses on your incoming messages. To use this feature, you must have an E-mail 
key field established.

To link messages automatically:

1. From the Tools menu, select Options.

The Preferences dialog box will open.

2. Click the TeleMagic tab.

The TeleMagic page will open.

3. Mark the Automatically link incoming mail checkbox.

4. Click OK.

5. Click Set Search Order.

The Select Databases dialog box will open.

6. Mark each database that should be searched.

The databases will be searched from top to bottom. 

7 Change a databases place in the list by highlighting it 
and clicking Move Up or Move Down.

8. Click OK.
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Using the Contacts with Merge Option Feature
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When using the Contacts with Merge Option feature, you will be able to send messages to all contacts 
in your TeleMagic filters, the current contact, or contacts identified using the search or browse 
functions. You can add merge attachments that are specific to each recipient, or add merge 
attachments that are identical for all recipients with merge information drawn from a linked contact 
record.

Certain restrictions apply when using the features on this page:
· You must send the message via the Automation Server. 
· Addressees selected from this page can only appear on the To: field of the address.
· You can only have one entry identified using this page.
· You must have an E-mail key field specified in Key Field Preferences for the database 

containing the addressees.
· You must be logged in to TeleMagic. (This does not mean that you must have TeleMagic 

open.)

1. Open the message for editing, or create a new message.

2. Click on the area to the left of the address fields.

The Select Recipients dialog box will open.

3. Click the Contacts with Merge Options tab.

The Contacts with Merge Options page will open.

4. Select the radio button indicating how you would like the 
message addressed:

NoneThis is automatically selected. You can select this 
radio button to remove any choices that you have already 
made.

Current Contact Select this radio button to send 
the message to the current contact.

Other Contact Select this radio button to make 
the Search button become available. See To Address a 
Message to a Contact for instructions on using the 
various options available.

Filter Select this radio button to send the message to 
all contacts in a filter.

If you selected any option other than Filter, proceed to 
step 7

5. Select the filter to be used from the drop-down list.

6. Select the level that filtered records are to be drawn from.

7. Click OK.

The Select Recipients dialog box will close. If you 



selected to send the message to a filter, TeleMagic Filter 
will appear in the To: field. If you selected a contact, 
TeleMagic Contact will appear in that field.

8. If you are not adding a merge attachment, proceed to 
step 14

9.
Click the Add a Merge Document button .

The Select Document dialog box will open.

10. Browse for the document to be attached from the tree 
view.

11. Select the source for the merge merge from the radio 
buttons:

· Select Contact Recipient(s) to use data from the 
recipient’s records to populate the merge fields in the 
document.

· Select Linked Contact to use data from the linked 
record to populate the merge fields in the document. 
(This option is not available if the message is not 
linked to a contact.)

12 Click OK.

The Select Documents dialog box will close. The 
selected merge document will appear in the Attachments 
section of the screen.

13. Repeat steps 9-12 for any additional merge documents 
to be attached to the message.

14. Add any other attachments to the message using the 
instructions in Attaching Files to Messages.

15. Compose and send the message using the instructions in 
Composing and Sending a Message as a reference.
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Command Line Parameters
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/CLEANREG A mailbox must be established before mail can be sent or received with 
TeleMagic Internet Mail. Part of establishing the mailbox includes making 
entries in the registry of the machine where the user works. If the user is 
deleted from TeleMagic, the mailbox is not automatically removed. To remove 
the mailbox, TeleMagic Internet Mail must be opened on the machine where the 
mailbox was established using the /CLEANREG command line parameter. To 
remove the mailbox, enter the following in the Windows Run dialog box:

C:\TM\TMMAIL.EXE /CLEANREG=???

Replace the path to TMMAIL.EXE with the correct path if necessary. 
Replace ??? with the user’s three-character ID. Be sure to include the space 
between TMMAIL.EXE and the forward slash (/). 



TeleMagic Internet Mail Main Screen



The New Message Screen



Recipient Type Fields

Move your mouse cursor near the recipient type you wish to address. When the field highlights, left-click 
the mouse to open the Address Book.



The Select Recipients Dialog Box



The Select Document Dialog Box



The Move to Folder Dialog Box

Your folders may differ.



The Copy to Folder Dialog Box

Your folders may differ.



Areas of the TeleMagic Internet Mail Main Screen



The Edit Your TagLine Dialog Box



The Preferences Dialog Box



The Display Preferences Page



The Server Preferences Page



The Delivery Preferences Page



The Spelling Preferences Page



The TeleMagic Preferences Page



The Automation Server Preferences Page



The Filter Preferences Page



The Address Preferences Page



The Address Book



The Card Properties Dialog Box



The Address Book, with Entries



The Group Properties Dialog Box



The Address Book, with Groups



Step 2 Note

If you choose not to logon using MAPI, click No and Internet Mail will open. The procedure ends 
at this point.

In order to send mail via the Internet you will need to either open TeleMagic Internet Mail using 
MAPI, or you will need to set up your Internet mail account in Tools, Options….

You must have a MAPI application established to successfully logon to TeleMagic Internet Mail 
using MAPI.



Step 2 Note

If installed by default on your C drive, the command will be C:\TM\PROGRAMS\TMMAIL.



Step 4 Note

Use your TeleMagic Userid and password.    Only established TeleMagic users in the installation 
associated with the current installation of TeleMagic Internet Mail will be able to login to the system.



Step 2 Notes

You can enter the name of the user as it appears in your address book, the full Internet address, or 
open your address book and select the recipient.

You must have at least one recipient in the To: field to send the message.    If you do not include a 
recipient in the To: line, the Send Message Now button will be unavailable.



Step 4 Note

You must enter a subject to be able to send the message.    A message may be placed in the On Hold 
folder without a subject.



Step 1 Note

You can also open the New Message screen by selecting Message, New Message from the main toolbar, 

or by pressing CTRL+N on the keyboard.



Step 1 Note

If you have moved the message, select the appropriate mailbox.



Step 2 Note

After opening the message to the Message screen, the status of the message will change to Opened.



Step 2 Note

There are three Address Books available:    TeleMagic, Internet, and MAPI.    In addition to the address 
books, you can select the Contacts and Contacts with Merge Option tabs. This procedure is only 
applicable when addressing messages to recipients in the Internet, TeleMagic Users, and MAPI 
address books.
· The Internet book contains Email addresses for individuals and other biographical information 

which you have entered.    You may assign individuals in this list to groups.
· The TeleMagic Users book includes all TeleMagic users in your system.    These users, and any 

groups they may be in, are established from within TeleMagic.
· The MAPI book is your MAPI address book and contains addresses established in other MAPI-

compatible applications.
· The Contacts tab allows you to select one of the filters from your database. The message will be 

addressed to all contacts in the selected filter. Any contacts in the filter who do not have email 
information will be ignored. You must have the E-mail Key Field defined in the database you are 
using. When you select recipients in this way, the To: field will indicate “TeleMagic Contact” or 
“TeleMagic Filter”.

· The Contacts with Merge Option tab provides you with the ability to send merge documents as 
attachments to contacts via the Automation Server.



Step 3 Hint

To select additional recipients, hold down the CTRL key and click on each additional name to be 
added.
or
To add a range of names to the list, select the name at the top (or bottom) of the list, hold down the 

CTRL+SHIFT keys and click on the name at the bottom (or top) of the list.    All intervening names will 
be selected along with the second name.
or
Click and hold the left mouse button and drag through all recipients you wish to select.



Step 4 Note

Any recipient to a message will be in one of three categories: To:, CC:, and BCC.
· To: - There must be at least one recipient on the To: line for the message to be sent.
· CC: - Recipients in the CC: category are essentially the same as those in the To: list.    Messages 

are generally sent to recipients as CC: (rather than To:) to indicate, for example, that there is no 
response to the message expected of them but that the message may be of interest to them 
nonetheless.

· BCC: -.Recipients on the BCC list will not be known to any other recipients, including other BCC 
recipients.    Reply to All has the same effect as Reply to Sender in the case of BCC recipients.



Step 2 Note

You may also select Message, Reply to Sender or Message, Reply to All rather than clicking on the 
buttons.

If Reply to Sender is selected, the response will be sent to the originator only.    If Reply to All is 
selected, the response will be sent to the sender and all CC: recipients.    In neither case will BCC: 
recipients receive a response.



Step 6 Note

Queue To will send the message to the Automation Server.

Save to Folder… opens a dialog box from which you can select any of the TeleMagic Internet Mail 
folders as a destination for the message.



Step 4 Note

Select the desired profile from the drop-down list and mark the Set as default profile checkbox to 
change your default profile.    The chosen profile will be automatically selected when you next login to 
TeleMagic Internet Mail.

Mark Show logon screens for all information services to see the logon screens for the information 
services you have selected in your MAPI application.    The logon screens will be displayed after you 
click Ok and this dialog box closes.    This option is not persistent.    The next time you open TeleMagic 
Internet Mail, you will need to select Options and mark this checkbox again to view the logon screens.



Note for Starting TeleMagic Internet Mail

Although TeleMagic Internet Mail may be opened and run as an independent program, it relies on your 
TeleMagic user list.    In order for the program to be opened, it must be located in the TeleMagic global 
directory and the user must be an established TeleMagic user—even if TeleMagic Internet Mail is being 
opened with TeleMagic shut down.



Step 3 Note

Click Yes to delete the message, or click No  to quit the process without deleting.

There is a preference which allows you to disable sending deleted messages to the Deleted Items 
folder.    If you select this preference deleted items will be permanently deleted regardless of where 
they are deleted from.



Step 3 Note

A number of options are available from this dialog box.    See the documentation for your operating 
system and printer for more information.



Step 1 Note

To open the message in the Message dialog box:
· Select the folder which contains the message you wish to open.
· Double-click anywhere on the message line.
or
· From the menu, select Message, Open….

The selected message will open in the Message dialog box.



Step 2 Hint

If you already have an attachment in the Attachment section of the Message dialog box, you can open 
the Open dialog box by right-clicking the existing attachment and choosing Add from the menu that will 
become available.
The Open dialog box will open regardless of whether the attachment you right-click is a file or a merge 
document.



Step 4 Hint

To close the Attachments section, select View from the menu and uncheck Attachments.    If this 
selection is not available, there are no attachments associated with this message.



Step 3 Note

This action will not delete the attached file.



Step 4 Note

You also have the option of changing the name of the attachment.    To do so, enter the new file name 
and extension in the File name: field.



Step 2 Note

To select additional recipients, hold down the CTRL key and click on each additional name to be 
added.
or
To add a range of names to the list, select the name at either the top (or bottom) of the list, hold down 

the CTRL+SHIFT keys and click on the name at the bottom (or top) of the list.    All intervening names 
will be selected along with the second name.
or
Click and hold the left mouse button and drag through all message lines you wish to select.



Step 2 Note

To open the message in the Message dialog box:
· Select the folder which contains the message you wish to open.
· Double-click anywhere on the message line.
or
· From the menu, select Message, Open….

The selected message will open in the Message dialog box.



Step 3 Note

It is possible to place any message on hold—even one which cannot be sent.    Prior to sending a 
pending message, verify that there is a recipient in the To: line and a subject in the Subject: line.



Note for On Hold Messages

This procedure assumes you have already composed a message and placed it in the On Hold folder.    
See Composing and Sending a Message for instructions on composing messages.



Note for Sending Mail from the Local Queue

This message assumes you have already composed a message and placed it in the Outbox. See 
Composing and Sending a Message for instructions on composing messages.



Note for Using the Address Book to Address a Message

This procedure assumes you are in the process of composing a message and have the Message 
dialog box.    See Composing and Sending a Message.



Step 4 Note

As is the case with any message, forwarded messages must have at least one recipient in the To: line 
and an entry in the Subject: line.



Step 3 Note

The original subject line will be prefaced with FW:.    You can change this if you wish, but there must be 
an entry on the subject line for the message to be successfully sent.



Step 3 Note

There is a preference which allows you to disable sending deleted messages to the Deleted Items 
folder.    If you select this preference deleted items will be permanently deleted regardless of where 
they are deleted from.



Step 3 Hint

To select multiple messages, hold down the CTRL key and click on each additional message line to be 
added.
or
To add a range of messages to be marked or unmarked, select the message at the top (or bottom) of 

the list, hold down the SHIFT key and click on the message at the bottom (or top) of the list.    All 
intervening messages will be selected along with the second message.



Step 2 Hint

You can print multiple messages, just select all of the messages you wish to print.

To select multiple messages, hold down the CTRL key and click on each additional message line to be 
added.
or
To add a range of messages to be marked or unmarked, select the message at the top (or bottom) of 

the list, hold down the SHIFT keys and click on the message at the bottom (or top) of the list.    All 
intervening messages will be selected along with the second message.



Step 2 Note

If the folder contains any messages you will be asked to confirm deletion of the messages.    If you do 
not wish to proceed, click No, otherwise click Yes.



Step 1 Hint

Regardless of which address line is highlighted when you open the Address Book, you will be able to 
make entries in any address line.    However, when you double-click on a name, it will be entered in the 
address line which was highlighted when you opened the Address Book.



Step 2 Hint

Once inserted in your message, you can edit, move, or delete the TagLine like any other text.



Hint for Show Folders

When you choose not to display the folders, the Message and Message Body sections of the main 
screen will be widened to occupy the space, thereby displaying more information.



Note for Warn me before permanently deleting mail

Mail will be permanently deleted if it is deleted from the Deleted Items folder or, if the Don’t send 
deleted mail to the Deleted Items folder checkbox is marked, whenever deleted. With this checkbox 
marked, you will receive a message under whichever circumstance is appropriate.



Note for Using This Help System

The icon you just pressed is the Note icon.    Notes are amplifying information which are intended to 
clarify an instruction.    Notes accessed from this icon are specifically related to a particular step in an 
instruction or, to a lesser extent, a specific paragraph in an explanation.



Hint for Using This Help System

The icon you just pressed is the Hint icon.    Hints are amplifying information which offer a strategy for 
using a particular feature, setting, or option.    They may point out a relationship between the feature 
being discussed and another feature.



Related Topics for Using This Help System

Actually, this is not a real Related Topics button.    There is a real one at the top of the topic you were 
just reading.    You can click on that one now to see what happens.    The related topics offered when 
you click on the Related Topics button are intended to be a broad selection, so there are usually quite a 
few of them.

This is not what you would normally see in a Related Topics window.    You can close this window in the 
usual manner.



General Note for Using This Help System

The button you just pressed is the General Note button.    This button will usually be found in the top 
section of the topic, along with the topic title and the Related Topics button.

The information found in these topics differ from other notes in that they are not specific to a particular 
step or paragraph.    For example, a general note for this topic may explain that most of the graphics in 
this topic are controls which will either give you more information or allow you to move to another topic.

Since you may need to reference a general note at any time while studying a topic, they are displayed 
in windows which you must close manually.



Mid-topic Hotspot for Using This Help System
Topics accessed from hotspots imbedded within the text will be displayed in a separate window from 
the first topic.    This allows you to minimize the window you were just in, make any required changes 
based on the secondary topic, and return to the original topic without losing your place.    These topics 
will stay on top so you can perform changes in TeleMagic without them automatically minimizing.

When finished with a secondary topic such as this one, simply close the secondary window in the usual 
manner.



Popup Hotspot for Using This Help System

Popup hotspots work just like the Note and Hint icons.    When you open a popup hotspot, the topic will 
close as soon as you click anywhere on the screen.    Popups may contain hotspot links to other topics. 
Popup Hotspots quite often display pictures of the feature or concept being discussed.



Continue Topic for Using This Help System

The Continue button will take you directly to another, closely related topic.    This button is used when 
there is only one other topic that is closely related.    This topic was specifically created to illustrate the 
Continue button, so it is not quite the same as others.    For one thing, it has no Related Topics button 
at the top.    For another, the Continue button, below, will lead you back to the Using This Help System 
topic.    Continue buttons are never labeled with the topic they lead to.

{ewc rhgbtn32.dll, BlueSkyHelpButton, g<contup01.bmp|
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Follow-on Topic #1

Unlike Continue buttons, the small buttons are labeled with their destination.    There will always be at 
least two of these sorts of buttons.    They will be located in the Continue… section of the topic.

Continue…
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
_____154.BMP<JumpId(TMMAIL.HLPï¿½Tmmailx_Continue_Topic_for_Using_This_Help_System)<
<1} Continue Topic for Using This Help System 
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_____154.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Using_This_Help_System)<<1} Using This Help 
System 
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Follow-on Topic #2

This topic was created to illustrate the Continue to Topic button.    The Continue button below will 
return you to the Using This Help System topic.

{ewc rhgbtn32.dll, BlueSkyHelpButton, g<contup01.bmp|
contdn01.BMP<JumpId(TMMAIL.HLPï¿½TMMAIL_Using_This_Help_System)<<1}



Note for Step 3

The only required information is the E-mail address.    If there is not an entry in Display as, then the E-
mail address will be displayed in the To: (CC: or Bcc:) line when the card is applied to a message.    It 
is possible to create an entry with no information, but such an entry will not be usable.



Step 1 Note

You must already have a list of recipients to establish a group.



Step 4 Hint

To select multiple individuals, hold down the CTRL key and click on each additional individual to be 
added.
or
To add a range of individuals, select the individual at the top (or bottom) of the list, hold down the 

CTRL+SHIFT keys and click on the individual at the bottom (or top) of the list.    All intervening 
individuals will be selected along with the second individual.
or
Click and hold the left mouse button and drag through all individuals you wish to select.

You can add all current individuals in your Address Book by clicking Add All.



Step 2 Note

To view the groups, double-click Personal Addresses.    The list of groups will be displayed below 
Personal Addresses.

To select multiple addresses, hold down the CTRL key and click on each additional address to be 
added.
or
To add a range of addresses, select the address at the top (or bottom) of the list, hold down the 

CTRL+SHIFT keys and click on the address at the bottom (or top) of the list.    All intervening 
addresses will be selected along with the second address.
or
Click and hold the left mouse button and drag through all addresses you wish to select.



Step 4 Note

When you delete a group, the members of the group will not be deleted.    You must specifically select 
individuals for deletion.



Note for Step 13

Logging on to TeleMagic does not launch TeleMagic. When TeleMagic Internet Mail is logged on to 
TeleMagic, it has access to your TeleMagic databases. This makes certain functions available that are 
not available when Internet Mail is not logged on to TeleMagic. For example, you must be logged on to 
TeleMagic to use the Contact Lookup function.
This setting only applies when launching Internet Mail external to TeleMagic. Internet Mail is 
automatically logged on to TeleMagic when launched from TeleMagic.



Note for Step 1

You can only edit the Address Book from the main TeleMagic Internet Mail screen. You cannot add new 
addresses if you have accessed it from the Compose Message dialog box.



Note for Addressing Messages

When you enter an address directly in an address field, you can edit it directly in the field. If you enter 
an address from an address book, you will not be able to alter it in the address field. You can delete the 
address from the address field no matter how you entered it.



Main Screen
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<RELAUP01.BMP|RELADN01.BMP<Klink(TeleMagic 
Internet Mailï¿½ ï¿½ ï¿½ )<<1}

Most sections of the Main Screen are optional. If you do not see a section that is described in this 
topic, open the View menu and mark the desired section.

Menus
Select the menu to access various options

· File Options on the file menu allow you to manage your folders, print messages, 
rebuild your mail tables, and exit TeleMagic Internet Mail

· View The View menu controls which sections of this screen are displayed. These 
settings are for the current session only. To change the sections displayed by default, you 
must change the settings in Preferences.

· Message Options for creating, forwarding, replying to, and performing other functions 
relating to specific messages are found on this menu.

· TeleMagic This menu allows you to coordinate messages with your TeleMagic databases 
by linking, viewing linked information, jumping to linked records, and other functions.

· Tools The Tools menu contains options that allow you to establish your TagLine, send 
and receive mail, search for text in messages, and set your TeleMagic Internet Mail options.

· Help Access the TeleMagic Internet Mail help system and retrieve information about 
your installation of TeleMagic Internet Mail.

Toolbar
The toolbar is optional and can be turned off by deselecting the option for it on the View menu. All 
controls on the toolbar have ToolTips to assist in determining their function. Hold your cursor over the 
control momentarily for the ToolTip to appear. Some tools are only available under certain 
circumstances.

· Exit TeleMagic Mail Click this tool to leave TeleMagic Internet Mail.
· Compose a New Message Click this button to open the New Message screen and 

compose a new message.
· Print the Current Message Click this button to print the selected message.
· Display the Address Book Click this button to open the Address Book.
· Reply to Sender Click this button to open the New Message screen with 

a new message addressed to the sender of the selected message.
· Reply to All Click this button to open the New Message screen with 

a new message addressed to the sender and all recipients of the selected message.
· Forward Message Click this button to forward the message to another 

recipient.
· Delete Message Click this button to delete the message. Deleted 

messages will be sent to the Deleted Items folder. Messages deleted from the Deleted Items 
folder are permanently deleted.

· Delete from Server Click this button to delete the message from the 
Automation Server.

· Go to Linked Contact Click this button to open the linked record in the 
Contact Manager. This button is only available if the message is linked and you are logged 
into TeleMagic.

· Contact Information Click this button to display key information for the linked 



contact. This button is only available if the message is linked and you are logged into 
TeleMagic.

· Lookup Contact Click this button to find a contact in the database that 
matches the sender’s e-mail address. You must be logged into TeleMagic for this button to 
be available.

· Send and Receive Messages Click this button to send all unsent messages and 
check for new incoming messages.

· Send Messages Click this button to send all unsent messages.
· Receive Messages Click this button to check for new messages. If you 

have established more than one account, a pop-up menu will open from which to select the 
account to be checked.

· Help Click this button to access the online help system.

Folders
This section of the display can be closed by deselecting the option for it on the View menu. There are 
six folders by default:

· Inbox Contains messages that have been received.
· Outbox Contains messages that are waiting to be sent.
· Deleted Items Contains messages that have been deleted. Messages deleted from 

this folder become permanently deleted.
· Sent Items Contains messages that have been sent.
· On Hold Contains messages that are not yet ready to be sent. Messages in this 

folder are not necessarily complete (they may not be addressed or have subject lines).
· Undeliverable Contains messages where the attempt to send failed.

You can add folders to this section, either to the root or as subfolders to existing folders. If a folder 
contains a subfolder, there will be a plus sign next to it in the tree view.

Folder Contents
This section of the screen is mandatory: it will always be displayed when this screen is open. There are 
7 columns in this section. You can resize the columns by placing your cursor near the border between 
the column headers and, when the cursor changes to a sizing arrow, clicking and dragging the border to 
the desired width. The first four are unlabeled and will display icons representing information about each 
message. The first four columns are:

· Mail Status The following icons may appear in this column:

ù Message has been opened

ù Message has been replied to

ù Message has not been opened

ù Message is pending

ù Message has been queued to the server

ù Message has been queued locally
· Attachment The following icon may appear in this column:

ù The message has one or more attachments
· Marked The following icon may appear in this column:

ù The message has been marked
· Linked The following icon may appear in this column:

ù The message is linked to a contact
The remaining three columns are labeled and will contain information about the message:



· To/From The intended recipient or author of the message. This column toggles between 
To and From, depending on which folder is being viewed.

· Subject The subject of the message. This column may be blank for some messages.
· Date Received/Last Modified The date the message was received or the date it was 

last edited. This column toggles between the two, depending on the folder being viewed.

Message Body
This section of the screen is optional. To prevent it from being displayed, open the View menu and 
deselect its item. When displayed, the text of the selected message will be displayed.

Status Bar
This section of the screen is optional. To prevent it from being displayed, open the View menu and 
deselect its item. When displayed, the status bar will indicate the number of messages in the current 
folder, and the number of unread messages.

More About…
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Add Folder
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<RELAUP01.BMP|RELADN01.BMP<Klink(TeleMagic Internet 
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Folder Name
Enter the name for the new folder in this field.

Type
Select the primary use for the new folder, either Inbox or Outbox. You can filter your mail so that it is 
sent to a custom inbox, or you can establish outboxes to be processed under different circumstances.

Add as a subfolder of:
Select the folder from the tree view that will contain the new folder. You can put the new folder in any of 
the standard folders, including Mailboxes. Custom folders cannot have subfolders.

More About…
{ewl rhgbtn32.dll, BlueSkyHelpButton, g<_____153.bmp|
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Modify Folder
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<RELAUP01.BMP|RELADN01.BMP<Klink(TeleMagic Internet 
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Only custom folders can be modified.

Folder Name
The name of the folder will appear in this field and can be changed.

Type
Select the primary use for the folder, either Inbox or Outbox. You can filter your mail so that it is sent to 
a custom inbox, or you can establish outboxes to be processed under different circumstances.

Add as a subfolder of:
Select the folder from the tree view that will contain the new folder, if different. You can put the new 
folder in any of the standard folders, including Mailboxes. Custom folders cannot have subfolders.

More About…
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New Message
{ewc rhgbtn32.dll, BlueSkyHelpButton, g<RELAUP01.BMP|RELADN01.BMP<Klink(TeleMagic Internet 
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Menus
Open the menus to access various functions related to the message you are composing. The following 
menus are available on this screen:

File Direct the message to be sent, queued, or held. View the message 
properties, or leave the New Message screen using options on this 
menu.

Edit Use options on this menu to cut, copy, paste, or select text.
Message Add attachments, choose to page recipients, store encrypted, and 

password protect the message from this menu.
TeleMagic Perform functions related to associating messages to your contact 

database from this menu, such as linking, creating activities, and 
creating To-Dos based on the message.

Tools Access the composition tools (Spell Check, Thesaurus, Text Search, 
Insert TagLine, and Replace) from this menu. Also access the 
Address Book from here.

Help Open the online help system and view information about your 
installation from this menu.

Toolbar
All of the tools on the Toolbar are provided with ToolTips to help identify their function. Some tools are 
only available under certain circumstances. The following tools are provided:

· Close Message Click this button to close the message and return to the 
main screen. You will be prompted to save changes before the message closes.

· Send Message Now Click this button to send the message immediately. This button 
is only available if the message has been addressed and a subject has been entered on the 
Subject line.

· Send Message Later Click this button to send the message to the Outbox. 
This button is only available if the message has been addressed and a subject has been 
entered on the Subject line.

· Hold Message Click this button to send the message to the On Hold 
folder.

· Queue to Automation ServerClick this button to send the message to the Automation Server. 
A pop-up menu will open from which to select the Automation Server queue that the 
message should be sent to.

· Reply to Sender/Reply to All/ Forward These buttons are not applicable to new 
messages.

· Save Message to Folder Click this button to open the Save to Folder dialog box 
and select the folder where the message should be sent. 

· Delete Message/Delete from Server These buttons are not applicable to new messages. To 
delete a new message that has never been saved, quit the New Message screen and reply 
No when prompted to save. To delete a new message that has been saved, access the 
message from the main screen and select Delete or Delete from Server.

· Add a File Attachment Click this button to open the Open dialog box and 
select the file to be attached to the message.

· Add a Merge Document as an Attachment Click this button to open the Select 
Document dialog box and choose the document to be attached. The message must be 



linked to be able to use this feature.
· Print Message Click this button to print the message.
· Link Message to a Contact Click this button to open the Link dialog box and select 

a contact to link the message to.
· Go to Linked Contact Click this button to open the linked record in the 

Contact Manager. This option is only available if the message is linked and you are logged 
on to TeleMagic.

· Contact Information Click this button to display key information about the linked 
contact.

· Lookup Contact This button is not applicable to new messages.
· Create an Activity Click this button to create an activity based on the 

message.
· Create a To-Do Click this button to create a To-Do based on the 

message.
· Spell Check Message Body Click this button to run a spell check on the body of the 

message.
· Help Click this button to open this help topic.

Font Controls
You can compose and send your messages using a variety of text effects. You can use virtually any 
combination of text effects. The following are available:

· Font Select any of your installed fonts from the drop-down list.
· Point Select from the available point sizes. Some fonts do not support some 

point sizes.
· Bold Click this button to toggle between boldface and non-boldface font. This 

can affect selected text, the next text to be typed, or both.
· Italic Click this button to toggle between italic and regular font. This can 

affect selected text, the next text to be typed, or both.
· Underline Click this button to toggle between underline and plain font. This can 

affect selected text, the next text to be typed, or both.
· Strikethrough Click this button to toggle between strikethrough and non-strikethrough 

font. This can affect selected text, the next text to be typed, or both.
· Color Select the font color from the drop-down list.
· Justification Click either the left, center, or right justified button. Selecting one automatically 

deselects the current selection.
· Toggle Rich Text Format Click this button to toggle between sending your messages in 

Rich Text Font or Plain Text. The current selection is indicated to the right of this button. 
Some mail readers do not recognize RTF. If you are sending in RTF and your recipient 
receives unexpected characters in the message, try sending in Plain Text. If you send in 
Plain Text, no special font effects will be seen in the received message.

Address Message buttons
The To:, CC:, and BCC: section of the screen are buttons. Click any of these button to open the Select 
Recipients dialog box.

Address Fields
· To: The address of the intended recipient of the message must appear in this field. 

This field must be filled in before the message can be sent. There can be multiple entries on 
this line, unless sending to a filter.

· CC:Additional recipients can be entered in this field.



· BCC: Additional recipients can be entered in this field. BCC recipients are not visible 
to other recipients.

Subject Field
Enter the subject of the message in this field. A subject is required to send the message.

Message Body
Compose the message in this field.
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Contact Info
Key information about the linked contact is displayed in this field.

Link to (No Link / Current Contact / Other Contact)
If you do not want to link this activity to a contact record, select the No Link radio button.

If you want to link this activity to the current contact, select the Current Contact radio button.

If you want to link this activity to any other contact record, select the Other Contact radio button. 

Search My Contacts For
This field becomes available when the Other Contact radio button is selected. Enter the information to 
be searched for and click Search. This will search the current database only.

Advanced Search
This button becomes available when the Other Contact radio button is selected. Click this button to 
open the Advanced Search dialog box and search for a contact in another database.

Browse Contacts
This button becomes available when the Other Contact radio button is selected. Click this button to 
open a browse window of the current database. Click on the desired record to link the sales forecast to 
that record.



Contact Info
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This screen displays key information about the linked contact. It cannot be edited.

Close
Click this button to close the message and return to TeleMagic Internet Mail.



Search
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Search for Text
Enter the text you want to find in this field.

Search in
Select the radio button that describes the scope of the search, either Current Folder Only or All 
Folders.

Search fields
Mark the checkbox(es) corresponding to the fields in the messages which should be searched for the 
text entered in the Search for Text field.

Results
Messages with matching text will be listed in this field. The field is divided into 3 columns: From, To, 
and Subject. This information will be listed for each message containing the search criterion.



Address Book
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Menus
Open the menus to access the Address Book’s features. The following menus are available:

· File Options on this menu allow you to add, delete, and edit cards in your address 
book. You can also exit the Address Book from here.

· View Certain sections of this screen are optional. Toggle them off and on from this 
menu.

· Help Access the TeleMagic Internet Mail online help, and view information about the 
application from this menu.

Toolbar
The Toolbar is optional. Toggle the Toolbar off and on by selecting and deselecting its item on the View 
menu. Each tool is provided with a ToolTip to help identify its function. The following tools are available:

· Close Address BookClick this button to close the Address Book and return to TeleMagic 
Internet Mail.

· Add a Card Click this button to open the Card Properties dialog box and 
add a new entry to the Address Book.

· Edit Selected Card Click this button to open the Card Properties dialog box and 
edit the selected card.

· Add a Group Click this button to open the Group Properties dialog box and 
create a new group.

· Edit Selected GroupClick this button to open the Group Properties dialog box and edit the 
selected group.

· Delete Click this button to delete the selected card or group. You will 
be prompted to confirm the decision to delete.

· Print Click this button to print the selected card.
· Help Click this button to access the TeleMagic Internet Mail online 

help, and information about the application.

Groups
This field is a tree view of the groups that have been added to the Address Book. Right-click in this area 
to open a floating menu and add a new group, or change or edit the selected group, or send mail to the 
selected group.

Cards
This field displays cards which have been added to the Address Book. The field is divided into four 
columns: Name, E-mail Address, Home Phone, and Business Phone. This information is listed for each 
card. Right-click anywhere in this field to open a floating menu from which you can create new cards, 
add cards to and remove cards from groups, delete cards, and send mail to the selected entry.

Directory Tabs
Select the tab corresponding to the first letter of the last name to restrict the cards displayed in the 
Cards field. This section is optional. Toggle the field by selecting and deselecting its item on the View 
menu.



Status Bar
The status bar indicates the number of items selected. This section is optional. Toggle the field by 
selecting and deselecting its item on the View menu.

More About…
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Edit Your TagLine
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Text Field
Enter the text of your tagline in this field.

Automatically insert TagLine into new messages
Mark this checkbox to use the TagLine automatically. If this is not marked, you will have to insert the 

tagline manually using the Insert TagLine item from the Tools menu, or by pressing CTRL+T.

More About…
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Preferences - General
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Send deleted mail to Deleted Items folder
Mark this checkbox for deleted messages to be retained temporarily in the Deleted Items folder. Items 
in the Deleted Items folder can be moved into any other folder. Messages that are deleted from the 
Deleted Items folder are permanently deleted and cannot be recovered. If this option is not selected, 
messages are permanently deleted regardless of which folder they are in when they are deleted.

Empty Deleted Items
Select the radio button that indicates when you want the Deleted Items folder to be emptied.

Warn me before permanently deleting mail
Mark this checkbox to be prompted to confirm the decision to permanently delete mail.

Include original message in reply
Mark this checkbox if you want the text of the original message included when you reply.

Include yourself when Replying to All.
Mark this checkbox if you want to receive a copy of your reply when you respond to a message using 
the Reply to All option.

Send mail as Rich Text by default
Mark this checkbox if you normally want your messages sent with all text formatting. If your mail is not 
sent as Rich Text, the message received will be in default font and formatting. Some mail readers do 
not recognize Rich Text Formatting. If a message in Rich Text Format is read with one of these 
applications, it will contain spurious character strings which make reading difficult.

Store mail encrypted
Mark this checkbox to store messages in a format which cannot be read without TeleMagic.

Attachment Directory
Click this button to open the Select Directory dialog box and browse for the directory where 
attachments to incoming mail should be stored. You can also enter the path directly in the field to the 
right of the button.

Mailbox Name
Enter the name of the mailbox in this field. The name will appear in the title bar of the main screen.

Password
Enter a password in this field to establish a password for TeleMagic Internet Mail that differs from your 
TeleMagic password. If you have a password here, you will need to enter it even when launching 
TeleMagic Internet Mail from within TeleMagic.

Make TeleMagic Internet Mail my default mail client



Mark this checkbox to make TeleMagic Internet Mail the default mail client. Your default mail client will 
be launched whenever an application calls for a mail editor. For example, if you are browsing a website 
and select a Send Mail hotspot, your default mail client is launched. In TeleMagic you can establish e-
mail fields. When you click the icon for one of these fields, your default mail client will be launched.
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Preferences - Display
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Show Toolbar
Mark this checkbox to show the Toolbar by default. You can override this in the current session by 
changing the selection in the View menu.

Show Status Bar
Mark this checkbox to show the Status Bar by default. You can override this in the current session by 
changing the selection in the View menu.

Show Folders
Mark this checkbox to show the Folders section by default. You can override this in the current session 
by changing the selection in the View menu.

Show Message Body
Mark this checkbox to show the Message Body section by default. You can override this in the current 
session by changing the selection in the View menu.

Font
Click this button to open the Font dialog box and select the default font and style to be used for 
displaying message text.

Use Default Display Configuration
Mark this checkbox to retain the defaults for how items are displayed on the screen. When this is not 
marked, you will be able to specify how items are displayed based on status.

Custom Display Configuration
Each status is listed on the left side of this section of the page. To the right of each, you can select the 
color and font style to be applied to each status. These selections affect the messages entry in the 
From, Subject, and Date Received columns when viewing the Inbox or Deleted Items folders, the To, 
From, and Subject columns when viewing the Deleted Items folder, and the To, Subject, and Last 
Modified column when viewing any other folder. As you change the settings, the name of the status will 
be displayed with the selected effects as an example. The following properties can be defined for each 
status:

· Color Select the font color from the drop-down list for each status.
· Bold Mark this checkbox for each status that should appear in boldface.
· Italic Mark this checkbox for each status that should appear in italics.
· Underline Mark this checkbox for each status that should appear underlined.
· Strikethrough Mark this checkbox for each status that should use the strikethrough 

style.
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Preferences - Servers
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Internet Accounts
All currently established accounts are listed in this field.

New
Click this button to open the Internet Account Wizard and create a new account.

Remove
Click this button to delete the selected account.

Properties
Click this button to open the Internet Account Wizard and edit the selected account.

Set as Default
Click this button to make the selected account the default account. There must be one default account. 

Logon to MAPI
Select the radio button that indicates your preference for logging on to MAPI. You can be prompted 
before logging on, always log on, or never log on.

Mailbox Name
Enter your MAPI mailbox name in this field. If this is blank, you will be prompted for a mailbox when 
logging on to MAPI.

Password
Enter your MAPI password in this field. If this is blank, you will be prompted for a password when 
logging on to MAPI.
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Preferences - Delivery
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Check for message every
Mark this checkbox to periodically check for messages. When this checkbox is marked, enter the time, 
in minutes, that should elapse between checking for new messages. You can either enter the time 
directly, or use the spinner arrows. Enter 0 to continuously check for new messages. If this checkbox is 
not marked, you will receive new mail only when you select to do so manually.

Don’t download messages greater than
Mark this checkbox to restrict the size of messages that you want to receive. If you mark this checkbox, 
enter the maximum size, in kilobytes, that you want to receive in the K field. You can either enter the 
amount directly, or you can use the spinner arrows.

When new mail is received, notify me
Select the radio button that indicates how you would like to be notified when new mail is retrieved. You 
can choose not be notified, or you can choose audible, visual, or both audible and visual notification. 
The visual notification is a pop-up message. If your choice includes an audible notification, indicate 
the .WAV file and path in the field. You can enter the path and file name directly, or click the ellipsis 
button and browse for the file.
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Preferences - Spelling
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Automatically spell check messages when sending or queuing
Mark this checkbox to perform a spell check on each message before sending it.

Ignore Uppercase Words
Mark this checkbox to ignore any words that are entirely uppercase when performing the spell check.

Ignore words containing numbers
Mark this checkbox to ignore any words which contain at least one number when performing the spell 
check.

Ignore HTML tags
Mark this checkbox to ignore any words in HTML tag format when performing the spell check.

Ignore URLs and E-mail addresses
Mark this checkbox to ignore any words in URL or e-mail address format when performing the spell 
check.

Check for repeated words
Mark this checkbox to alert on the second consecutive occurrence of the same word when performing 
the spell check.

Auto-Suggest
Mark this checkbox to have the spell checker offer a list of suggested spellings for misspelled words.

Recheck replaced words
When the spell checker finds a word that it does not recognize, it gives you the opportunity to enter 
another spelling. Mark this checkbox to perform a spell check on words entered in this way. Words 
replaced from the suggested list are not rechecked.
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Log on to TeleMagic
Select the radio button indicating your preference for logging on to TeleMagic. You can choose to be 
prompted before logging on, always log on, or never log on. You must be logged on to TeleMagic in 
order to use certain features, like linking and displaying linked information. You can be logged on to 
TeleMagic without it being open. If you are logged on with TeleMagic closed, you will be able to link 
messages to contacts using the Advanced Search feature and display contact information, but you will 
not be able to Link to Current Contact. If you choose Never, the remaining options on this page will 
have no effect.

Enter the location of your TeleMagic installation
Enter the path to TeleMagic. You can enter the path directly, or you can click the Modify button and 
browse for the Installation.

UserID
Enter your TeleMagic user ID in this field.

Password
Enter your TeleMagic password in this field.

When using Goto based on the e-mail address, look for the contact in
Select the radio button indicating how you want to search for contacts when using Goto. You can 
choose to check only the current database, all databases, or check the current database and be 
prompted before checking other databases.

Automatically link incoming mail
Mark this checkbox to have TeleMagic Internet Mail search your databases for contacts with e-mail 
addresses matching the sender’s address on incoming mail and linking the message to that contact. 
You must have the E-mail key field established in each database with which you want to use this 
feature.

Set Search Order
This button becomes available when you have chosen to automatically link incoming mail. Click this 
button to open the Select Database dialog box and select the databases to be searched, and in what 
order.

Stamp Notepad
Mark this checkbox to mark the notepad of the linked contact and record that a message was sent.

Create Activity
Mark this checkbox to create an activity based when a linked message is sent.



Preferences - Automation Server
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Automation Server Accounts
All currently established Automation Server Accounts are listed in this field. You must set up 
Automation Server accounts to be able to retrieve mail using the Automation Server.

New
Click this button to open the Automation Server Mail Account Setup dialog box and establish an 
Automation Server account.

Remove
Click this button to delete the selected Automation Server account.

Properties
Click this button to open the Automation Server Mail Account Setup dialog box and edit the selected 
Automation Server account.

Send e-mail notification of failure
Mark this checkbox to have the Automation Server send you an e-mail message whenever one of your 
messages that was sent via the Automation Server fails.

Fail on invalid merge field
Mark this checkbox to fail any message if the attached merge document contains an invalid field.

Stamp Notepad
Mark this checkbox to stamp the notepad of linked contacts when a message to them is sent via the 
Automation Server.

Create Activity
Mark this checkbox to create an activity based on the message when sent via the Automation Server.
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Preferences - Filters
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Filters are used in TeleMagic Internet Mail to redirect incoming messages based on the content of 
specified fields. You can place messages in specified folders, or you can automatically pass them on to 
others.

Current Filters
All current filters are listed in this field.

New Filter
Click this button to open the Mail Filter Properties dialog box and create a new filter

Remove
Click this button to delete the selected filter.

Properties
Click this button to open the Mail Filter Properties dialog box and edit the selected filter.

More About…
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Preferences - Addresses
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Select the radio button indicating your preference as to how names are displayed. This setting affects 
the Address Book and, indirectly, the address lines on new messages. This setting can be overridden 
on individual cards. Changing this setting does not affect cards that are already in the Address Book.
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Select Directory
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Directories:
This field displays a tree view of the selected drive. Double-click on the folder to select it.

Files:
This field displays the files contained in the selected field.

Drives
Select the desired drive from the drop-down list.



Internet Account Wizard - General
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Tabs
There is a tab corresponding to each step in the setup procedure. When establishing a new account, 
you will not be able to access subsequent pages until mandatory information has been filled in on 
earlier pages. When editing an existing account, you can go directly to the page that contains the 
setting that you want to change.

Description
Enter the description of the account in this field. The description appears on the Internet Accounts field 
of the Preferences dialog box - Servers page, and on the pop-up menu that appears when you 
manually receive mail.

Make this my default account
Mark this checkbox to make this account the default account. There must be one default account. The 
default account is used for all outgoing mail. Which account is the default account can be changed as 
required. 

Continue takes you to the next step in the procedure.
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Internet Account Wizard - Send
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I am known as
Enter the name you want to appear in the From field of your outgoing mail in this field.

E-mail address
Enter the e-mail address as it would be entered by someone sending you a message in this field.

SMTP Server
Enter the SMTP (outgoing) mail server in this field. If you connect to the Internet with a direct modem 
connection (as opposed to using a LAN), obtain this information from your ISP. If you connect to the 
Internet via Local Area Network, obtain this information from your network administrator.

SMTP Port
This is set to 25 by default. Do not change this setting without specific instructions from your ISP or 
network administrator.

Continue takes you to the next step in the procedure.
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Internet Account Wizard - Receive
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POP3 Server
Enter the POP3 (incoming) mail server in this field. If you connect to the Internet with a direct modem 
connection (as opposed to using a LAN), obtain this information from your ISP. If you connect to the 
Internet via Local Area Network, obtain this information from your network administrator.

User Name
Enter the user name for this account. The format for this entry must be compatible with your 
connection. If you connect to the Internet directly, obtain this information from your ISP. If you connect 
using a LAN, obtain this information from your network administrator.

Password
Enter the password used to obtain incoming mail from your mail service. If you leave this entry blank, 
you will be prompted for a password whenever you retrieve mail.

POP3 Port
This field is set to 110 by default.    Do not change this setting unless specifically instructed to do so by 
your network administrator or ISP.

Always retrieve mail from this account
Mark this checkbox to retrieve mail from this account whenever you check for mail. This option is 
always marked for the default account. When mail is retrieved, the default account and any account 
with this checkbox marked will be queried for new messages.

Delete message from the server
Mark this checkbox to delete messages from the server when they are retrieved. If you do not mark 
this checkbox, you will continue to retrieve messages that you have deleted locally until they are 
deleted from the server. 

Continue takes you to the next step in the procedure.
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Internet Account Wizard - Connection
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Use Dial-up Networking/RAS
Select this radio button if you connect to the Internet using a modem (as opposed to connecting via 
Local Area Network). If you choose this radio button, select the dial-up connection from the drop-down 
list.

Username
Enter the name used to gain access to the ISP in this field.

Password
Enter the password used to gain access to the ISP in this field.

Connect using my Local Area Network (LAN)
Select this radio button if you connect to the Internet via Local Area Network.

Finish
Click this button to accept all parameters, and close the Internet Account Wizard.



Automation Server Mail Account Setup
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Automation Server Mail Account data is provided to the Automation Server. The Automation Server 
requires this information to be able to retrieve mail. Each established account will be checked for new 
mail according to the E-mail Specific settings established in the Automation Server.

Description
If you are adding a new Automation Server Mail Account, enter the name that will appear in the 
Automation Server Accounts field of the Preferences dialog box, Automation Server page in this field. If 
you are editing an existing account, this field will indicate the name of the account being edited and 
cannot be changed.

Host Name
Enter the POP3 (receive mail) server name in this field.

User Name
Enter the user name recognized by the mail service (ISP) to access this account.

Password
Enter the password used to access this account on the mail service in this field.

Port
This value is preset to 110. Do not change this setting unless instructed to do so by your ISP.

Delete Messages from the Server
Mark this checkbox to delete messages on the mail service after they have been retrieved. If you do 
not mark this checkbox, you will continue to retrieve messages that you have deleted locally until they 
are deleted from the server.



Mail Filter Properties
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Mail filters are used to automatically direct incoming mail to folders other than the Inbox, forward them 
to other recipients, or delete them based on the presence of specified text in selected fields of the 
message being filtered.

Description
Enter or edit the name of the filter in this field.

When receiving mail containing text:
Enter or edit the text that will cause the action of the filter to be executed.

Case sensitive
Mark this checkbox to require that the case of the text be considered when matching the test criterion 
to the contents of the message.

In fields:
Mark the fields where the test criterion can    be found to cause the action of the filter to be executed. 
You can select any combination of the To, CC, From, Subject, and Message Body fields.

Perform the following
Select the radio button that describes the action to be taken when the test criterion is met. You can 
choose to move the message to a particular folder, delete the message, redirect the message to 
another recipient, or forward the message to another recipient. If you choose to redirect or forward the 
message to another recipient, enter their e-mail address in the text field. If you choose to redirect the 
message, the message will not appear in any of your folders.

Select Folder
This button becomes available if you choose to move the message to a folder. Click this button to open 
the Select Folder dialog box and choose the folder to send the message to.

More About…
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Copying Messages to Other Folders 
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Select Recipients - TeleMagic Users
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User List
This field contains a list of all TeleMagic Users. Highlight the user to be added to the list of recipients.

To
Click this button to add the selected user to the To: field of the message. You can enter as many users 
on this line as you like, unless you are sending the message to a filter. If you are sending to a filter, 
only the filter can appear on this line. Filters are added to this line from the Contacts with Merge Option 
page.

CC:
Click this button to add the selected user to the CC: field of the message. You can enter as many users 
on this line as you like. You cannot CC to a filter.

BCC:
Click this button to add the selected user to the BCC: field of the message. You can enter as many 
users on this line as you like. You cannot BCC to a filter. Recipients in this field will not be seen by 
other recipients of the message.
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Select Recipients - Internet
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Recipient List
This field contains a list of all Addresses that you have added to the Address Book Highlight the entry 
to be added to the list of recipients.

To
Click this button to add the selected recipient to the To: field of the message. You can enter as many 
recipients on this line as you like, unless you are sending the message to a filter. If you are sending to 
a filter, only the filter can appear on this line. Filters are added to this line from the Contacts with Merge 
Option page.

CC:
Click this button to add the selected recipient to the CC: field of the message. You can enter as many 
recipients on this line as you like. You cannot CC to a filter.

BCC:
Click this button to add the selected recipient to the BCC: field of the message. You can enter as many 
recipients on this line as you like. You cannot BCC to a filter. Recipients in this field will not be seen by 
other recipients of the message.
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Select Recipients - Contact
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To,CC:,BCC:
Click these buttons to open the Advanced Contact Search dialog box and search or browse for the 
recipients. Which button is selected will determine in which field the selected contact is entered. You 
can enter as many recipients on each line as you like. Optionally, you can enter a filter on the To: field. 
If a message is sent to a filter, there can be no other recipient in the To: field. You can put an unlimited 
number of recipients on the CC: and BCC: fields in addition to addressing the message to a filter. Filters 
are added from the Contacts with Merge Option page.
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Select Recipients - MAPI
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MAPI Address Book
Click this button to open the MAPI Address Book. If this button is not visible, you may have chosen to 
launch the MAPI address book automatically, or you have opened the MAPI address book manually.

Automatically Launch MAPI Address Book
Mark this checkbox to open the MAPI address book whenever this page is opened. If this checkbox is 
not visible, you may have chosen to launch the MAPI address book automatically, or you have opened 
the MAPI address book manually.

Show names from the:
Select the list that you want to display from the drop-down list.

Type name or select from list:
Enter the name of the recipient in the field, or click on the recipient in the list. If you start entering a 
name, the closest match will be highlighted in the list.

To
Click this button to add the selected recipient to the To: field of the message. You can enter as many 
recipients on this line as you like, unless you are sending the message to a filter. If you are sending to 
a filter, only the filter can appear on this line. Filters are added to this line from the Contacts with Merge 
Option page.

CC:
Click this button to add the selected recipient to the CC: field of the message. You can enter as many 
recipients on this line as you like. You cannot CC to a filter.

BCC:
Click this button to add the selected recipient to the BCC: field of the message. You can enter as many 
recipients on this line as you like. You cannot BCC to a filter. Recipients in this field will not be seen by 
other recipients of the message.

New
Click this button to open the New Entry dialog box and add a new entry to the MAPI address book. You 
must have appropriate rights to create entries in the MAPI address book.

Properties
Click this button to open the Properties dialog box for the selected entry. You may be able to edit the 
entry from this dialog box if you have the appropriate rights.

Find
Click this button to open the Find dialog box and search for an entry.



OK
If the MAPI address book is open, click this button to close the MAPI address. If the MAPI address 
book is closed, click this button to close the Select Recipients dialog box.
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Select Recipients - Contacts with Merge Options
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You must process messages that are addressed from this page through the Automation Server.

Information Field
Key information about the contact, or the name of the filter selected, is displayed in this field.

Select Contact
Select the radio button that indicates the contact to whom the message should be addressed. If you do 
not have TeleMagic open, you will not be able to select Current Contact or Filter. If you select Filter, 
choose the TeleMagic filter to be used to address the message from the drop-down list. 

Search
This button becomes available when you select Other Contact. Click this button to open the Advanced 
Contact Search dialog box and search or browse for the contact.

Send to filtered contacts from level
Select the database level which contains records of the contacts to whom the message will be sent.
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Advanced Contact Search
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Search for:
Enter the string to be searched for in this field. The entire string does not need to be entered. The first 
record matching the search criteria will be selected.

Search
This button becomes available when an entry has been made in the Search for: field. Click this button 
when you are ready to begin the search.

Database:
Select the database to be searched from the drop-down list.

Level:
Select the level to be searched from the drop-down list. 

Index:
Select the index to be used to search for the search criterion. The first field in the index expression is 
used to find the match.

Browse
Click this button to open a Browse menu and search for the record manually. The records will be 
ordered according to the index indicated in the Index field.



Select a Contact
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Field Display
Most of this dialog box is a display of records in the selected database. All fields that are marked to be 
included in browse are listed. The field prompt for each field is shown in the header of each column. 
You can change the width of any column by momentarily placing the cursor over the border between 
one of its borders. When the cursor changes to a sizing arrow configuration, click and drag the border 
to the desired position. You can also change the relative positions of the columns by placing the cursor 
over the column header. When the cursor changes to an arrow, click and drag the column to the 
desired position.

Maintain Previous Browse Settings
Mark this checkbox to keep any changes you make to the Browse display.

Select 
Click this button to use the selected record and close the Select a Contact dialog box.



Thesaurus Lookup
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Topic
The general class of currently displayed suggestions is indicated in this field. You can go back to 
previously displayed topics by selecting them from the drop-down list.

Word
The word being considered is displayed in this field. If a word was highlighted in the message when the 
Thesaurus was opened, it will appear here. This field can be edited to look up other words.

Topic List
The available topics for the word under consideration are listed in this field. Click on the desired topic 
and suggestions will be listed in the Suggested Replacements field.

Tabs
Click on the tab to see a list of suggested alternatives of the type of word indicated. There may be tabs 
for nouns, verbs, adjectives, and adverbs. Some of these tabs may not be present for certain words.

Suggested Replacements
This field contains the suggested replacements from the selected topic of the type indicated by the tab. 
Click on a suggested replacement to select it.

Lookup
Click this button to retrieve the available topics for a word that was manually entered in the Word field.

Replace
Click this button to replace the highlighted word in the message with the selected word in the 
Suggested Replacements field.



Message Properties - General
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The following information is indicated on this page:
To The contents of the To: field. This would be either the addressee(s), or the filter 
used to determine the addressees.
From: The contents of the From: field. This is the immediate source of the message, 
either the originator or the individual who forwarded the message.
Subject:The contents of the Subject: field.
Location: Which folder contains the message.
Size: The size of the message.
Status: The status of the message.
Date Sent: The date the message was originally sent.
Date Received The date the message arrived.



Message Properties - Headers
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This page contains information from the message header. This information may be useful for 
troubleshooting.



Receiving
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Done
Click this button to close the dialog box.

Details/No Details
Toggles the Receive Monitor on and off.

Close Window When Finished
Mark this checkbox to automatically close the dialog box when all messages have been received.

Receive Monitor
Current status of the message retrieval is displayed in this field.



Card Properties - Personal
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First
Enter the contact’s first name in this field.

Middle
Enter the contact’s middle name in this field.

Last
Enter the contact’s last name in this field.

Display as
Select how the contact’s name should appear in the Address Book from the drop-down list.

E-mail Address
Enter the contact’s e-mail address in this field.



Card Properties - Home
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Address
Enter the contact’s home street address in this field.

City
Enter the contact’s home city in this field.

State
Enter the contact’s home state, province, district, or other location information in this field.

Zip
Enter the contact’s home ZIP or postal code in this field.

Country
Enter the contact’s country of residence in this field.

Phone
Enter the contact’s home phone number in this field.

Fax
Enter the contact’s home fax number in this field.

Pager
Enter the contact’s personal pager number in this field.



Card Properties - Business
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Name
Enter the name of the contact’s business in this field.

Address
Enter the address of the contact’s business in this field.

City
Enter the city where the contact’s business is located in this field.

State
Enter the state, province, district, or other location where the contact’s business is located in this field.

Zip
Enter the ZIP or Postal code for the contact’s business in this field.

Country
Enter the country where the contact’s business is located in this field.

Phone 
Enter the contact’s business phone number in this field.

Fax
Enter the contact’s business fax number in this field.

Pager
Enter the contact’s business pager number in this field.



Card Properties - Notes
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Use this page as a memo pad to make notes of any kind that may be relevant to the contact.



Group Properties
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Group Name
Enter or edit the name of the group in this field.

Available
The names of all available cards in your address book appear in this field. Click on a name to select 
the card.

Add/Add All/Remove/Remove All
Click on the appropriate button to add or remove members of the group.

Members
Cards that have been selected for the group are indicated in this field.



Save to Folder
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Select the folder that is to contain the message by clicking it and click OK.



Select Databases
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Select the databases you would like to search
Mark the checkbox next to each database that should be checked for records with matching e-mail 
addresses.

Move Up
Click this button to move the selected database up the list. The higher the database is on the list, the 
sooner it will be searched. The search stops as soon as a match is found, so the database most likely 
to contain matching records should be at the top of the list.

Move Down
Click this button to move a database down on the list. Databases farther down the list are checked 
after those higher on the list.



Automation Server Settings Dialog Box
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The settings on this dialog box only apply to messages sent via the Automation Server.

Priority
Select a priority from the drop-down list. This setting affects the order in which the message will be sent 
if other messages are being sent at the same time. 

Hold Time
Enter the date and time that the message should be sent, if there should be a delay. If a time in the 
past is entered, the message will be sent as soon as possible.




